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Introduction

Welcome

The Financial Support Services Unit was established by the Department of Education
and Skills under Circular M36/05. The Unit provides support and training to schools
in the Voluntary Sector on all aspects of school finances.

The Unit endeavours to ensure that schools have a robust and supported
computerised accounts package. It is of paramount importance that school
management and Trustees/Patrons can fulfil their obligations in terms of financial
accountability for State and other funding.

The FSSU was made aware in September 2014 that the TAS accounting software
package currently in use by the majority of FSSU schools, would no longer be
supported and developed by Sage. In assessing the risk that our schools may be
exposed to not having a supported computerised accounts package, it was decided
that the process of sourcing and implementing a new package should commence.

We are confident that Sage 50 will meet all requirements, giving assurance and
confidence to our schools.

As with all aspects of requirements around financial management obligations in our
schools, | would like to assure you that full support and training from the FSSU will be
available on an ongoing basis for the operation of Sage 50.

Louise McNamara
Director, Financial Support Service Unit

July 2016
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1.1 Install Sage 50 Accounts software

1.1.1 Install Sage 50 Accounts on a single computer

m Before you start your installation please ensure you close all software.

1. Print your Email from Sage showing your Serial Number and Activation Code

2. Download your copy of Sage 50 Accounts using the link in the email » Sage 50
Accounts V22 — Full Program » Install Full Version of software.

3. To accept the terms and conditions » select the check box » Next.

Sage 50 Accounts

Software Licence Agreement

Your use of this product is subjectto our standard terms and condiions. It you have purchased a fixed -
termiperpetual licence for the Software, the Software Licence Agreement in Part A applies fo you. If you have
purchased a subscription for the product and support then the Terms and Conditions in Part B apply to you. Ifyou
don't accept the provisions as set outin Part A or Part B (as applicable) then you should natinstall, access or use

this product in any way,

PART A — FIXED TERM LICENCE AGREEMENT
This agreement describes how you are allowed to use the Software. Ifyou acceptthis agreement you can use the
- : b -

Software only as inthis and the Please make sure you are happy
with all the tarms in this agreement before you install the Software.

‘ot indirate that vnin anras to all the tarms of thi frnm tha sarliact date wni fick 2 hox ar click on 3 hiton ™

[]1 accept the terms of the Licence Agreement

Cancel

4. To ensure that you install all of the required files » Standard (Recommended) » Next.

Sage 50 Accounts

Installation type

Standard (Recommended) Recammended for most users, The installation location is automatic.
Advanced Recommended for users who wish to choose the installation lacation.

Essential if this computer does notrequire the Sage 50 Accounts software, but will

B Secbice ol ik i ke P iy o 15 oo

Cancel

The software will install into the path shown.

Exa If you're using a 64-bit operating system, the default path is
m C:\Program files (x86) \Sage\Accounts.

If you're using a 32-bit operating system, the default path is
C:\Program Files\Sage\Accounts
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5. To begin the installation of Sage 50 Accounts » Yes, begin installation.

6. This process usually takes a few minutes to complete.

Sage 50 Accounts

Confirmation
The program willinstallinto the following location:

Ci¥Program Fies (x86)\Sage |Accounts

The program will be accessble from the following folder in the Windows Start menu:

Sage Accounts

Do you want to continue?

T | e

7. To complete the installation and launch Sage 50 Accounts » Launch Sage 50 Accounts.

Sage 50 Accounts

Installation complete

Cangratulations, your program has installed successfully

Launch Sage 50 Accounts | | Close

Congratulations, the installation is complete and you're now ready to setup your New
Sage software.

<« BACK TO CONTENTS »
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1.1.2 Registration

When you open Sage 50 Accounts for the first time, the Sage 50 Accounts Software
Registration window appears.

Sage 50 Accounts - Software Registration | & |

Activate Sage Software

Activation Information

Serial Mumber; | |

Activation Key: | |

To activate your software you must enter your serial number
and activation key. These can be found on the advice note
you received with the software, ar within the DVD case.

If you can't find yvour serial number or activation key, dick on
the My Sage button to assist you in finding this information.

If you are unable to find your details using this service, you
can speak to an advisor on 1890 88 20 &0,

MySage | | Continue | | Cancel

% For assistance, please call 1890 882 060

Enter the serial number and activation key provided with your software » Continue.

@ Congratulations, you've now successfully registered your software
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1.2 Install Sage 50 Accounts on a network

If you have a computer in the office which is already connected to the school server by other
software you should install Sage 50 Accounts on the server. The server computer normally
has the software installed on it and also stores the data files, the office computer has the
software installed, but connects to the server for the data. The software must be installed on
the office computer and the server.

1.2.1

1.2.2

Install Sage 50 Accounts on a server computer

The steps to install the software on your server computer are exactly the same as
installing on a single computer, simply follow the steps in the previous section.

Share a folder on your server computer

To link your office computer to the data on your server computer you must first share a
folder on the server, making it visible to the rest of the network.

The folder you need to share is located as follows:
C:A\ProgramData\Sage\Accounts\20xx

The steps to share a folder on the server computer differ depending on the operating
system. In all cases the folder needs to have full control of the Share, and Modify
permissions on the folder contents.

If you're unsure how to do this, consult your IT administrator, the Windows help system,
or call Sage Technical Support on 1890 88 20 60.
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1.3 Installing FSSU Chart of Accounts

1. Once you have installed the Sage 50 software you will need to setup a data set for your
school.

The FSSU has created a standard company modified for schools and we recommend
that you use this standard company to set up your school on the SAGE 50 accounts
system.

2. The FSSU will email this customised company to you as an attachment. Save the
attachment of the standard company to you desktop

3. The file nameis FSSU...... and
1. Select setting up a new company
2. Login Name - MANAGER
3. Password - leave blank
4, In the first window, select
* Restore data from a backup file - go to your desktop and select the saved FSSU file.
* Restore this file to Sage 50.

Restore M

Which backup do you want to restore?

Previous backups

If this is on a removable storage device, insert this now.

File®; |C:‘JJsers\Jﬁtheen.JMBDOMAIN\Desktop‘I,SageAccts F| I Browse...

Description of data to be restored for: F55U Master

F55U Master -
Backup of :
- Data Files.

Backup details

Company name: FS5U Master
Data wersion: W22
Your backup will be restored to

Company name: F55U Master

Location: C:\PROGRAMDATA\SAGE\ACCOUNTS\20 16\COMPANY. 001}

| Ok || Cancel || Help |

Network Sharing — If you use multi user version of Sage 50 Accounts, we recommend that
you share your data across the network. This step prompts you to approve the network share.
If you have a single user version of the software this step doesn't appear.
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1.4 Installing FSSU Board of Management
Reports

The Sage 50 system will enable schools to run reports in each module and the
recommended reports will be given in the manual.

The recommended reports for the Board of Management will be produced from a suite of
reports designed for schools and Sage 50 reports. The excel designed reports are linked
directly to the Sage 50 system and are updated each time the reports are generated. The
reports must be saved to the computers desktop.

The recommended excel reports are:

1. Income and Expenditure Account — Actual activity /Budget/One year past
2. Balance Sheet — Actual/ One year part

3. Income and Expenditure Month by Month -Actual

Welcome, let’s get started’
To close the ‘Welcome, let’s get started’ window page
Tools > options > view » initial view > global settings and click

‘Don't display the welcome page'’
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1.5 Customising School Settings and
Preferences

When you open Sage 50 accounts this screen will be displayed:

Selef.:t Company [ 28 |
e
R+ M E3;
Add Remove Printlist Open Folder

Company Company Location
Company name 5] |Sage Drive |"."EI'5i|:|I’| VAT registration |Fir|aru:i.al year ||::|ata path
Practice data C:Programd
FS5U SAGE 50 w22 September 2015 C:\Programd
F55U Master v22 April 2016 C:\Programd
Fss5U w22 April 2016 C:\Programd
Demanstration data C:\Programd

| oK | | Caneel |

Select the required data set for your school and click OK to continue.

The Login window is presented.

Manager is the standard Logon Name click Ok to open data set.

Logon \

j Welcome to Sage 50 Accounts, e

Please enter your logon name and password,

Logon name™® | Manager |

Password | |
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Select Settings/Company preferences/details

1. Name - settings/company preferences. Enter your school name (enter the school roll
number at the end of your school name) and school address.

Company Preferences u
Accountant | Budgeting | VAT | Sage Pay |
Labels | Parameters | Reporting |

Mame | St Mary's College 60010F |

Streetl Dublin Road

Street2

Town Dublin 14

County

Post Code

Country |Ire|and E e |

Telephone | 012690677 |

Fax | |

Email | Fsu@imbie |

Website [[www. b el |

Credit Ref [ |

DUNS Number [ |

2. Financial Year — settings/financial year- choose the month your current financial year
starts from. The school financial year is from 1st September to the 31st August.

Financial Year | P |

Change Financial Year g
-ﬂw—- =
Change Finandal Year

oK | | Cancel |
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Currencies ﬁ

Mumber |Name |Code Symbol |Exchange Rate

1 Pound Sterling GBP £ 0.000000
2 US Dallar usD g 0.000000
3 Euro ELR € BASE

4 Argentinean Peso ARS & 0.000000
5 Australian Dollar ALD g 0.000000
& Brazilian Real BRL 4 0.000000
7 Canadian Dollar CAD g 0.000000

Euro

Exchange rate: 1.000000 %= | BASE Currency

Reverse: 1.000000

Currency units: euro and cents

3. Currency — settings/currency-check it is setup for the EURO

[= | You can’t change this at a later date, so it’s vital that you choose the
ﬂ right currency.

< BACK TO CONTENTS »



FSSU SAGE Accounts Manual Section 1: Set Up

1.6 Setting Password and Access Rights

Password

Change Password — The default login for Sage 50 Accounts is Manager. With this login you
have access to all of the software features, therefore we strongly recommend that you create
a password for this. Create a Manager password and individual user accounts. It's important
that you make your Sage data files as secure as possible.

Select a password that is easy to recall such as the School Roll Number.

If you didn't set up a Manager password when installing the software, you can create a
password, now. To do this, open Settings » Change Password > enter the required
password into the New Password and Confirm New Password boxes » OK.

Change Password ﬁ

Logon Mame MAMNAGER

New Password [ 1
Confirm Mew Password I:I

Keep this password in a safe place and email it to the principal immediately.
Please give this password to the principal immediately.

5E Remember this password as you can’t open the software without it.

Only the person logged on as Manager can create new users and modify the
areas of the software they can access.

If you have multi user version of the software you're prompted to log on. The default logon
is Manager with no password, unless you have already added a password. If you're using a
single user version, the software opens.
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Setting up Access Rights

From the menu bar, select Settings » Access Rights » New » enter a User Name and

Password
Edit user ﬂ
User name | Bursar
Password | |
Set Access to @
(OFull Access  (O)No Access 9 6
Description
i B[] Customers Mone |
M- [ ] Quotations Mone
[+ [] Sales erders Meone r
&[] Invoices & credits Mone
- [m] Suppliers Partial
&[] Purchase orders Mone
- [ Products and services Mone
- [m] Bank accounts Partial
- [+] Nominal codes Full
B[ VAT Mone
- [+] Transactions Full
- [+] Fixed assets Full ‘
- [v] Departments Full
&[] Projects MNone
i &[] Diary Mone N
- [v] Excel Integrated Reporting Full
- [w] File menu Full
... [v] Wizards Full
- [v] Settings menu Full
- [+] Tools menu Full
- [w] Help menu Full
oK | | Cancel

Define the areas a user can access

To define a user's access to a module, select or clear the linext to each module as required.
To specify access within each module, click the + to show the areas within the selected
modules. You can then select or clear the tinext to each option as required.

Note:

*  Only the MANAGER can change other user’s rights

*  Amendments are activated the next time the user signs in to the system
*  Modules and menus removed in access rights are removed from display
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1.7 Shortcut Keys

The following is a list of recommended keys that will help you use Sage 50 Accounts and
enter transactions quickly and easily:

F1 F1 will take you directly to the help files and is sensitive to the area of the program
you are working in

F2 | Opens the Calculator

F3 | This function key will open an item line in invoices and credits

Fa Displays the calendar, calculator or finder search list if the selected text box has
any of these special buttons attached.

To activate the spell checker in a text field or the currency converter in a numeric

Fo field

F6 | To copy the information from the field above

F7 | Will allow you to insert a line

F8 | Will allow you to delete a line

Fo Within Customer, Supplier and Bank data entry screens, this will calculate the net

and the VAT values of a transaction if the gross value is entered
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1.8 Backup manager

To keep your data safe, it's really important that you take regular backups of your data. As
long as you have backups, if your computer fails or your data becomes corrupt, you can easily
recover lost work and avoid hours of re-entering lost information.

Anyone can forget to take a backup, and if you're on a network it's not always easy to get
everyone to log out while you back up. With the new Sage Accounts Backup Manager,
managing your backups is simple. You can schedule backups to run automatically so you
don't need to worry about it, and you don't need to stop processing in Sage Accounts while
your backups are running. Check data runs automatically and you can manage backups and
check data results for all companies in one place.

To open the Sage Accounts Backup Manager

1. Open Sage Accounts » Logon name » enter manager.

2. Password » enter your password for the manager logon >» OK.
3. File » Schedule backup.
4

Within the Sage Accounts Backup Manager you can manage your backup schedule and
previous backup files C\SageBackups\V.22

o1

To refresh the information in the Sage Accounts Backup Manager »» Refresh.
6. To save any changes » Save

7. Please back up your SAGE 50 accounts to an external device (USB Key, External hard
drive) at least once a week.

Overview

For each company, this section summarises the following information:

Users How many users are currently logged in to the company.

Check data Whether or not check data has been run. If check data has been run, it
shows if any errors, warnings or comments were found.

Scheduled Whether the scheduled back up and check data is currently switched
backup status | on or off. You should check this area regularly. If any errors appear you

should stop processing in the relevant company and fix the errors.
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1.9 File Maintenance Problems Report

Data corruption is a serious risk to any school and any resulting data loss can be very costly.
The Check Data option checks your data files for corruption and where possible gives you
the relevant tools to fix your data.

We recommend you check your data regularly, particularly before you take a backup and
after you restore your data.

If you schedule your back up, your data is checked before the data is backed up.

An explanation of the File Maintenance Problems Report is detailed below, you can access
the report from File » Maintenance » Check Data.

Errors Indicates corruption in your data.

If you have errors we strongly recommend that you restore a backup
of the data prior to the errors occurring.

If you don't have an error free backup click the Errors tab and follow
the procedures on https://my.sage.co.uk/public/mydata.aspx to
correct the corruption on your data before you continue processing. If
you continue to process with errors your financial statements may be
inaccurate.

Warnings These are issues with your data that aren’t necessarily caused by
corruption but you should still correct them. For example, aged
balances on your control accounts do not equal the balance of the
outstanding transactions.

To resolve any warnings in your data, please refer to the steps on
https://my.sage.co.uk/public/mydata.aspx

Comments Comments don't necessarily require immediate attention. However,
they do indicate minor inconsistencies in the data, which you should
investigate. For example, transactions dated beyond the current
processing date, which may indicate the transaction has been entered
incorrectly.

To resolve any comments in your data, please refer to the steps on
https://my.sage.co.uk/public/mydata.aspx

Recovery Tools | You can use this option to fix the errors, warnings and comments in
the data. However, you must ensure you use the correct options for the
relevant issue.

Full details about which options to use for your errors, warnings or
comments, can be found on https://my.sage.co.uk/public/mydata.aspx

<« BACK TO CONTENTS »
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Settings

In this area you can set up how often you want to run a backup, what you want to include and
where the backups are saved.

Back up Choose how often you want to run the backup and check data: Back
schedule up and check data off - No scheduled backups run.

» Back up and check data once per day - Enter the time you want the
backup to run each day.

» Backup and check data more than once per day - Enter the backup
frequency and the starting time.

Company Select the companies you want the backup schedule to apply to. The

name same schedule applies to all selected companies.

File types to Select the types of file you want to include in your backups. Accounts

include in the data is always included.

backup

Backup By default, backup files are saved to C:\SageBackups on your server

location computer. If your server has alternative drives, you can choose the
drive you want to use.

Server disk New backup files are no longer created once the server's hard drive

space limit runs out of disk space. By default, 5 GB of space is left on the server's

hard drive. You can change this if required.
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1.10 Amend Transactions-Edit/Unallocate/Delete

Everyone can make mistakes, that's why you have the option to amend transactions after
you've posted them. If you make a mistake on a transaction or you enter a transaction in
error, within the Transactions module you can correct, reverse or delete your transactions.

Sometimes you may want to refund a transaction or post the opposite transaction manually.
Before you correct transactions, you are strongly advised to take a backup of your data files.

All users must be logged off before you can amend transactions.

To correct a transaction:

Open the Transactions module » select the transaction you want to amend or
delete » use the following options:

If you click Edit or Delete from the Transactions window the same window appears with slight
differences.

Edit You can use this option to edit the individual item lines of a transaction.

Unallocate You can use this option to unallocate transactions. For example,
unallocating a sales invoice from a sales receipt.

Delete You can view but not change the individual item of a transaction. You
only have the option to delete the transaction.

Some of the details within a transaction are known as critical fields. If you amend a critical
field the original transaction is deleted and a new transaction is posted. Some transactions
can't be corrected or deleted and must be reversed.

Critical fields Account, Bank, Date, N/C (Nominal Code), Net, T/C (tax code) and
Tax.

Note: You can't edit critical fields on journals. If you post foreign
currency transactions you can only amend the Exchange rate.

Non-critical Details, Department, Reference, Ex. Ref., Bank Reconciled flag, Bank

fields Rec. Date and Exchange rate.

If you amend a critical field, this:
* Raises a new deleted transaction with the original details.
* Amends the relevant information on the original transaction.

If you amend a non-critical field, the Edit option makes the changes to the original
transaction and no new transaction is created.
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The following information shows which fields can or can’t be amended.

Account The customer or supplier account reference. If the transaction is not
associated with a customer or supplier this field doesn't appear.
From the drop-down list you can choose a different account reference.
Bank The bank account reference, this only appears on bank transactions.
From the drop-down list you can choose a different account reference.
Reference Transaction reference.
Description Description of the transaction.
Created on The date used on the transaction.
Posted on Shows the software date when the transaction was entered.
You can’t edit this field.
Edited on Shows the system date when the transaction was last edited.
You can’t edit this field.
Net Net value of the transaction or batch of transactions.
To amend this value, click Edit.
Tax Tax value of the transaction or batch of transactions.
To amend this value, click Edit.
Posted by The Sage user who posted the transaction.
You can’t edit this field.
Edited by The Sage user who last edited the transaction.
You can’t edit this field.
Bank rec on This only appears on bank transactions.
If this is selected, it also shows the date the transaction was bank
reconciled on.
Paid The amount of the transaction which is allocated and not outstanding.
You can’t edit this field.
Paid in full Selected if there's nothing outstanding on the transaction and it's fully
paid or allocated.
You can’t edit this field.
Opening Selected if the transaction was entered through the OB option within a
balance record.
You can’t edit this field.
Disputed Selected if the transaction has been marked as a disputed item.
You can’t edit this field.
Printed Selected if you printed a cheque for this transaction.
You can’t edit this field.
Item Line If the transaction is made up from multiple item lines, the individual
Details item lines appear here.
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To amend the details on an individual item line, select the line » Edit.

To save the changes » Save » Yes.

Number 10, Bank Payment u

Before deleting this transaction and its assocated items, review the information below to make sure you
have selected the correct transaction.

I Bank Payment Details

Bank 1300

Reference 123455

Description New Boiler Posted by MAMAGER

Created on 044052016 = Edited by

Petedon

Curency i d
Exchange rate 1.000000 =

Item Line Details

No [N/C |Details Net|T/C

10 5350 Mew Boiler 2500.00 T8 0.00}

To view details of a specific item on this Bank Payment, highlight the item and didk "View'. View

How will this affect my data?

Delete a Transaction

If a transaction has been entered twice or incorrectly use the corrections options in the
Transactions module to delete it. Find the transactions you want to delete then click the
delete option on the toolbar. Confirm you want to delete the transaction by clicking Delete on
the corrections screen. The transaction is coloured red and marked as deleted in the audit
trail.

HIGH RISK- Do not delete bank transactions which have been reconciled.

< BACK TO CONTENTS »



2.1

2.2
2.3
2.4
2.5
2.6
LT

Getting familiar with Sage b0 Screen layout
Menu bar

Enter Opening Balances

Setting the processing date

Entering Uncleared Bank Account Transactions
Importing Customer and Supplier Details

Entering the Budget






To help you get used to the different options, this section explains how to navigate the
software,

The Sage 50 Accounts desktop is the main window within the software. It’s the
starting point from which you can access the features you’ll need to manage your
accounts, so it’s really important to be familiar with how it works.

Title bar The shows the name of the Sage software you're using and
the name of the company you have open.

If more than one window is open, the title bar for the active window,
the one in which you're working, has a different colour - normally
darker, to the title bars of the other windows.

Menu bar The contains several menus, each with its own set of
options.
To open a menu, click on the menu name or press ALT + LETTER at
the same time, where LETTER is the underlined letter in the menu
name.

For example, to open the Tools menu, press ALT + T. This opens the
drop-down list,

Control menu The Control menu box is in the upper-right corner of each window.
They look like this: FETTa EE
The left button minimises the window, the middle button expands the
window so that it fills the screen and the X button on the right closes
the window.

Status bar The status bar displays the Sage 50 Accounts user name, computer
name, software date, financial year start date and last transaction
number.

To view or hide the status bar, go to View > Status Bar.

Navigation bar | The navigation bar, which appears on the left hand side of the desktop,
provides quick and easy access to the main areas of your software,
referred to as modules.
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Work area

The main section of the software window, where information appears

and you enter data. You can choose between the following displays:

List - Shows a list of items appropriate to the selected module. A

toolbar across the top of the window displays the options available

for the module.

Throughout this help system, the step-by-step procedures assume

that you have a list window display.

Process map - Shows the workflow associated with the selected

module.

Dashboard - Shows key information for the selected module.

You can switch the process maps and dashboard view features on and
off within Tools > Options > View.

When these features are active, when you open a relevant module, the

display options appear below the module name.

File Edit View
Customers
Quotations

Sales orders

Invoices and credits

Suppliers

Purchase orders
Products and services
Bank accounts
Mominal codes

VAT

Transactions

Fixed assets

Departments

Diary

Modules Settings Tools  Favourites  Weblinks Help

< BACK TO CONTENTS »



Located at the top of the desktop, the menu bar contains various options that control a

number of software functions.

File  Edit View  Modules

Settings

Tools Favourites  Weblinks Help

Some examples of key school processes which you can access via the menu bar are:

File > Back up

File > Schedule back up

File > Restore

File > Maintenance > Check Data
File > Microsoft Integration
Settings > Company Preferences
Settings > Change Program Date
Tools » Options > View

Tools > Internet options

Tools Period End > Year End

Help > Contents and Index

Help > Shortcut Keys

You can use this to make a secure copy of your
data files.

Use this feature to schedule regular automatic
backups of your data.

You can use this to restore a copy of your data
files, returning them to a state before the backup
was created.

You can use this to check that your data is free
from corruption. We recommend that you run this
whenever you use the software.

You can use this to link Sage 50 Accounts to the
Microsoft Office suite.

Contains all of your company details including the
address and VAT information.

Set your defaults for all transactions and invoices
you enter in Sage 50 Accounts.

Customise your software in terms of the default
desktop and ledger views.

Enter your automatic update settings and online
account information.

Use this option to run your year end routine at the
close of your financial year.

Comprehensive software help files. You can also
access these at any time by pressing F1 on your
keyboard.

Details of how to navigate quickly and efficiently
using the keyboard.
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When you start using Sage 50 Accounts you will need to enter a trial balance to represent
your financial position. Preparing for this routine is vital. The accuracy with which entries are
posted is imperative to ensure success.

1. Decide on the date you are going to start using SAGE 50.

2. Print the Trial balance for the current year including opening balances from TAS -TAS
134 report.

3. Check the account codes on TAS Trial Balance to the FSSU Standard Chart of Accounts.
Change the codes on the Trail Balance where necessary.

4. If you use additional nominal codes to the standard FSSU chart of accounts you will
need to create these codes. See section on creating nominal codes. Only setup New
Nominal codes which are absolutely essential for your school’s accounts. New Bank
Account Codes must be setup using the BANK Module in SAGE.

5. The Opening Balances Wizard guides you through the process.

6. To open the wizard go to > Tools > Opening Balances. Select ‘enter the trial balance
from your accountant’

Cpening Balances M

The following series of actions will guide you through all of the necessary steps to ensure that
your Opening Balances are entered correctly. Ensure each step is ticked after you complete it.

Enter a default date for your opening balances e
Enter opening balances for your customers e

Enter opening balances for your suppliers 0

Beee]a

Check the customer and supplier opening balances e

=

Reverse the nominal balances in preparation for entering the trial balance 0

Enter the trial balance from your accountant 0
Enter the undleared transactions for your bank account(s) e
Check opening balances against the trial balance from your accountant e

Check your data e

E OB R OB B OE EH OE E E

LI

Backup your data 9

7. You must enter the complete Trial Balance before saving.

8. Enter the figure from the TAS Trial Balance using the last day of the period e.g. If the
TAS 134 report was ran for period 1 to 10 (September to June) use the 30th of June
XXXX as the date of input.

9. Save the Trial Balance.

10. Print a trial balance and agree to the TAS trial balance.
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11.

Tools » opening balances » Check opening balances againt the trial balance from your
accountant.

Criteria for Period Trial Balance

Criteria Values

Period To {inclusive) VI 2: October 2016
Preview a sample report for a specified number of records or transactions (0 for all) o 3:
crs

Enter date of trial balance as final period used in TAS 134 report e.g. June XXXX"

*  Check the opening balances against the TAS trial balance and investigate any
differences

+ Check Data

* Run the ‘check data’ wizard to ensure all data entered correctly

* A warning is displayed if there are any discrepancies and these must be corrected
before continuing.

* Backup

* Take a backup of your data using the wizard. See Back up Manager.

* To backup go to File > Backup. You will be prompted to check your data. It is best
practice to check your data at this point. If the check returns any errors you should
contact the FSSU for assistance. After closing the check data routine you will be
presented with the backup window.

Company details -

You are about to create a backup of:

Previous backups

Company name: FSSU SAGE 50

Foundin: C:\PROGRAMDATA\SAGE\ACCOUNTS\2016\COMPANY. 003\

-~ Where do you want the company backed up to? -

To select 3 location to save this badkup to, dick Browse. We have suggested a
filename for this backup. If you are happy with this suggestion, dick OK.

Backing up to removable media? Insert the device before dicking OK.

The Backup manager can back up your data automatically. For more information,
press F1.

Filename: | SageAccts FSSU SAGE 50 2016-06-02 12-05-28.001 |

Location™: | C:\SageBackups\v22\FS5U 03032016 |

Browse...

| oK | | Cancel | | Help |

*  From here you can choose your filename and backup location. Click OK to backup.
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When you're processing in Sage 50 Accounts the date you use on every transaction is
of critical importance to the accuracy of your data. By default, Sage 50 Accounts uses the
date from Windows as its default date, that is, today’s date.

If you want to change the default processing date, you can do this in:

Settings > Change Program Date

-
Change Program Date w

Enter a new date to be used as the default for transactions.
This date can be changed at time of posting.

s

Default Program Date | 01/10/2015 o

| 0K || Cancel |
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2.5 Entering Uncleared Bank Account
Transactions

The accountants year end adjustments to the bank accounts must be completed before
running the report. The TAS unreconciled report matching the closing bank reconciliation
summary for the period is required..The unreconciled transaction will need to be entered
separately.

1. To enter the outstanging transaction on the bank account select the Opening Balances
Wizard.

2. To open the wizard > Tools > Opening Balances.
3. Select ‘enter the uncleared transaction from your bank account(s)’

4, Follow the wizard and enter the transactions.

e s

|Mame |Department™ [Type |Amount=

1300 Current Account 31/10/2016 OBl 0 Receipt 5000.00 T9 0.00
1300 Current Account 31/10/2016 235556 0 Payment 2000.00 T9 0.00
1300 Current Account 31/10/2016 235580 0 Payment 500,00 T2 0.00

L | save I|Cance|

5. Print the unreconciled report and agree to the Bank Reconciliation report(s)

Bank Accounts > Reports > Unreconciled Bank Transactions

Check the opening balances against the trial balance from TAS and
investigate any differences.

Check Data
Run the ‘check data’ wizard to ensure all data entered correctly.

A warning is displayed if there are any discrepancies and these must be corrected before
continuing.
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Back up
Take a backup of your data using the wizard. See Back up Manager.

To backup go to File > Backup. You will be prompted to check your data. It is best practice
to check your data at this point. If the check returns any errors you should contact the FSSU
for assistance. After closing the check data routine you will be presented with the backup

window.

[ Back up ﬁj

Back up company Company details
Advanced options

PR You are about to create a backup of:

Company name: FSSU Master

Foundin: C:\PROGRAMDATA\SAGE\ACCOUNTS|2016\COMPANY, 001}

Where do you want the company backed up to?

To select a location to save this backup to, dick Browse. We have suggested a
filename for this backup. If you are happy with this suggestion, dick OK.

Backing up to removable media? Insert the device before dicking OK.

The Backup manager can back up your data automatically. For more information,
press F1.

Filename ;| SageAccts F5SU Master 2016-05-04 16-18-53.001 |

Location™; | C:\SageBackups v 22\FSSU Master |

From here you can choose your filename and backup location. Click OK to backup.
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The Data Import wizard can enable you to quickly import information fron TAS to Sage. The
import routine allows for the creation of new records or updating specific parts of existing
records leaving the rest of the data unchanged.

To import the names and addresses etc of the TAS suppliers run the report in TAS and
export to excel.

Use the template for suppliers and copy the information into the correct columns. Remenber
there must be no text or blank rows. The account codes must be less than 8 characters.

Once you have compleded the template save it to your desktop.

To import the template select File > Import

1. The data import wizard appears recommending that you perform a Backup before

proceeding.
Data Import M
Data Import
Welcome Welcome 9
‘fou can import data from Excel worksheets (*.xls;* xlsx) and files containing e
Data Type comma-separated values (*.cav).

To help you import your data, templates with the correct import structure are
Data Source available here.

Field Mappings

Import

020;0,0; -

WARNING: The Data Import procedure is NOT reversible.

It is strongly recommended that you backup your current company Backup
data before proceeding.

Cancel

m
it
sl
=
m
=
-9
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2. Click next and select the data type from the list > Supplier Records

Data Import M

o Welcome Data Type™ 9
Select the type of data you want to import: o

y3 Data Type Audit Trail ransactions
Customer records
Fixed Asset records

o Data Source Mominal accounts
Product records

5 . Project records
° Field Mappings Project-Only transactions
Stock take

o Import Stock transactions

| e [ nee ]

3. Select the format type and Browse your desktop for the template prepared earlier.

Data Import u

Data Import

o wlarie Data Source 9

Select the format of the data you will be importing:
° Data Type (O Comma-separated (*.csv)

(®)Excel worksheet (*.xds; =.xlsx)
3 Data Source

Select the file to impart™;
o Field Mappings |c:\'stMary5551mE\Copyof5upplier Record FULL template. s

e T [¥]First row contains headings @)

| | Browse...
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4. The field mapping screen appears and if using the Sage template liittle or no mapping
will be required.

f Data Import ﬁ1

Data Import

o Welcome Field Mappings 9

Map the fields in your data to the fields in Sage 50 Accounts,

° Data Type

e Data Source Account Reference
Account MName Account Name

L3 Field Mappings Street 1 Stest 1

Street 2 Street 2

o Import
Town Town
County County
Postcode Postoode

Map file in use: [none]

Clear Map | | Load Map... | | Save Map... |

T

5. The import window appears summarising the options chosen. To proceed click Import

[ Data Import u |

Data Import

o Welcome Import 9

‘fou are now ready to import your data.

o Data Type The following is a summary of the options you have chosen. If you need to change any
of them, dick the Back button now.
o Data Source Data type: -
Supplier records

° Field Mappings Data source:
Copy of Supplier Record FULL template. xls

L3 Import

Sheet:
Supplier Record Template

Header row:
Yes

To begin importing your data, dick Import.

Import
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6. The import results window appears showing all records imported/not imported.

r is Imported

ADTO01, ADT Fire & Security Ltd A
ADV001, Advanced Learning |]
ALLDO1, Allianz Insurance

ALLWO1, Allwin

ALUO1, Barbara Aluk

AMAZ0D1, Amazing Brains

ASHD02, Ashville Media Group Ltd

ATLOO1, Atlantic Fire

AUR002, Aurivo tfa Connacht Gold Retail Stores

BO1, Bord GAis

BALLOO1, Ballisodare Pharmacy -

- Records not Imported

Print | | Save Errors... | | Edit Import | | Help

7. If the import fails, correct the area of the spreadsheet listed in the error message and
complete the import process again.
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Before entering the creditor’s details it is important that any adjustments made by the accountants
at the year end are reflected in the creditor’s balances. A detailed aged creditors report will be used
to enter the balances. It is very important to check that the total on the creditors list agrees with the
creditors total on the trial balance.

Opening Balances Wizard guides you through the process.
» To open the wizard go to > Tools > Opening Balances.

» Select ‘enter opening balances for your suppliers’’Customers

7 5
Opening Balances &J

The following series of actions will quide you through all of the necessary steps to ensure that ﬂ
your Opening Balances are entered correctly. Ensure each step is ticked after you complete it.

Enter a default date for your opening balances e ]

Enter opening balances for your customers 9 ]

Enter opening balances for your suppliers 0 ]

Check the customer and supplier opening balances 0 il

EE: Reverse the nominal balances in preparation for entering the trial balance a Fl

Enter the trial balance from your accountant 9 ]

ﬁ Enter the undeared transactions for your bank account(s) 0 ]

Check opening balances against the trial balance from your accountant e IF]

n.g Check your data &) ]

L‘-'l:' Backup your data a ]
= o
(s opie: Cpe el =

Balance ‘ 5100.00

|Name |Ex. Ref |Department®  [Type
ADTOO1 ADT Fire & Security Ltd 31/10/2016 Q/Bal 0 Invoice 100.00
ALLODL Allianz Insurance 31/10/2016 O/Bal 0 Invoice 5000.00

When the balance are input run Tools > Opening Balances and select ‘Check the
customer and supplier opening balances'.

When the balances agree run Tools > Opening Balances and select ‘reverse the nominal
balances in preparation for entering the trial balance’.

Enter the total of the creditors as a debit entry.
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The FSSU budget template should be used when preparing the school budget. Sage 50
Accounts can integrate with Microsoft Excel. To help you input the school budget to Sage 50,
we have created an Excel budget template that you can use to enter the budget figures you
want to import. The budget must be entered at the start of each school year. Do not use the
future budget option.

A B C D
B Name - Yearly Budget Month 1 Budget *
3010 Capitation 60000
3020 Enhanced Capitation (DEIS) 30000
3050 Support Services 40000
3100 Secretarial Grant 21000
3130 Caretaker Grant 16700
3150 Book Grant 2000
3170 Special Subjects Grant 200
3190 Home Economics 5000
3200 Transition Year 36
3210 Leaving Cert Applied 200
3220 Grant for Traveller Students 202
3230 Computer/it Grant 1959
3240 Supervision/Substitution
3250 Substitute Teachers o
3255 DES Exam Income 10000
3270 Library 4000
3275 DES Minor Works Grant -non capital o]
32090 Other DES Grants 1769
3300 Fees | Fee Paying School) 1000
3310 Transition Year 5000
3330 Book Rental 1000
3335 Classroom Books o
3350 Hall Rental o
3370 Locker Receipts o]
3375 Journals & Year Book Income 2000
3390 School Administration Charges o]
3410 Adult Education Grant o
3420 Canteen Income 3000
3430 Tuck Shop Income o]

Enter the budget figures in the template provided.

Each line must have an account code and there must be no blank or text only lines
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When the template is complete go to Sage 50 Accounts, click File > import

Data Import | = |
Data Import
{8 Welcome Welcome e

You can import data from Excel worksheets (*.xls;=.xlsx) and files containing (2]

o Data Type comma-separated values (*.csv).
To help you import your data, templates with the correct import structure are

° Data Source available here.

o Field Mappings

o Import

WARNING: The Data Import procedure is NOT reversible,

It is strongly recommended that you badkup your current company Backup.
data before proceeding.

Select Data Type “Nominal accounts

Data Import | ® |
Data Import
Welcome Data Type™ 9
Select the type of data you want to import: o
Data Type Audit Trail transactions

Customer records

Data Source

Product records
i : Project records
Field Mappings Project-Only transactions
Stock take
o Stock transactions

030,08, - 20

Supplier records

Next

H
2
3
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Click Next for Data Source

Data Import | = |

Data Import

o Welcome Data Source 9

Select the format of the data you will be importing:

° Data Type (C)Comma-separated (*.csv)

D (@) Excel worksheet (%, xls; = xlsx)
urce

Select the file to import®:
° Field Mappings | C:\Kathleen Files\Kathleens Files\SAGE'Pilot Schools\Excel Reports's

o Import [¥]First row contains headings 0

I Browse...

[ s

Click Browse and find the Budget template file.

The budget template will only integrate if the fields in the template and Sage 50 Accounts
match.

1. Complete the Imported Field column as required, choosing the relevant field from the
drop-down lists.

Tip: If you need to remove your selections and start again, click Clear Map.
Use Save Map to record a map so you can use it again. Use Load map to
load a map you have already saved.

2. Once all of the required fields have been mapped > Next > check the information
Import.

Data Import | =& |

Data Import

o Welcome Field Mappings 9

Map the fields in your data to the fields in Sage 50 Accounts.

o Data Type Required  |Imported Field

o Data Source if _REﬁ-l -Refn
Mame Name

L3 Field Mappings .Yearly Budget -Yearly Budget

.Momh 1 Budget -Momh 1Budget

e Import I |
Month 2 Budget Month 2 Budget
|Month 3 Budget |Month 3 Budget
.Monﬁ'l 4 Budget Month 4 Budget

Map file in use: [none]

Clear Map | | Load Map... || Save Map... |

Cancel | Back | | Mext |

The budget will now be available in Sage 50 Accounts
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3.1 The Bank Accounts window

To help you to manage and maintain your cash flow, this window gives you quick and easy
access to all of the bank options.

New/edit From the drop-down list you can choose:

New - To create a new bank record.

Edit - To edit an existing record

Wizard - To be guided through creating a record.

Duplicate - To create a new account based on the details of an
existing, selected record.

Activity Opens the activity window for any selected account. This window
shows a list of the transactions for the account.

Reconcile Match the activity on your bank account record to those on your
bank statement. You can match transactions manually or by using
E-reconcile.

Bank transfer Record the movement of money between your bank accounts.

Payments From the drop-down list you can choose:
Supplier payment - To pay an individual supplier.
Batch supplier payment - To pay multiple invoices.

Bank payment - To record bank payments for transactions not
associated with a customer or supplier. For example, petrol costs or
bank charges.

Customer refund - To process a refund for a customer.
Remittances - To print a remittance advice if required.

E-payments - To record payments if you pay your suppliers
electronically.

Customer Record customer receipts to clear outstanding invoices.
Receipt
Bank receipt Record bank receipts for transactions not associated with a customer

or supplier. For example, interest or grant money.

Supplier Use this option to record any refund received from your suppliers.
refund

Recurring Set up transactions that are made on a regular basis such as direct
Items debits and standing orders.

Cash register Use this option to record cash till takings.

Deposit cash When you deposit cash takings at the bank, you can record it here.

Cash Flow Manage your cash by forecasting the money you expect to pay in and
out of the business.
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Delete You can use this option to delete a bank account.

Clear You can use this option to clear any account selections.

Print List Use this option to print a list of your accounts and balances.

Send to Excel | You can use this option to export a list of your accounts and balances
to Excel,

Statement Generate statements for each bank account.

Reports Access bank reports using the Report Browser.
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Section 3: Bank Module

3.2 Creating New Bank Account

The nominal accounts you want to use for bank transactions are created from the Bank
Accounts module and not the Nominal codes module.

This guides you through the set up and helps to ensure you don't miss any key information.

You can access the New Bank wizard in Bank accounts » Wizard.

New Bank

Bank Information

i8N Account Name

o Account Details
o Bank Details

o Contact Details
o Opening Balance

Account Name 9

To create a new bank account you need to enter the bank account name and a unique
reference.

The next available account code in sequence has been entered for you. You can keep
this reference or enter your own instead.

‘You can assign an account type to your new bank account . You can also choose
whether or not you want to reconcile this account in the future.,

Account type |Cheque Account v

[[IMo bank reconciliation

Cancel

Name The description that appears in the Bank Accounts window to help you
to identify the account, for example Bank Current Account.
You can enter up to 60 characters.
Ref A unique reference that identifies the bank account in your Chart of
Accounts (COA). You can't change this.
The code must have a least four digits and no more than eight,
between 0001 and 99999999,
Account type From the drop-down list you can choose one of the following:
* Cheque Account
» Cash Account
* Credit Card Account
Once you enter transactions into the account, you can't change its
type.
Each account type generates its own transaction types. For example,
payments can be bank payment (BP), cash payment (CP) or visa
payment (VP), depending on whether the account type is a cheque
account, a cash account or a credit card account.
No Bank If you don't want to reconcile this bank account, select this check box.
Reconciliation
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Account Details

Account No. You can enter up to 60 characters for the bank account number.

Account name | The name of the account.

Minimum limit | The amount that you don't want the balance of this account to drop
below. If the amount of money you have in this account goes below this
amount the bank appears in red in your Bank Accounts window.

Sort code The bank sort code.

Expiry If this account is for your company credit card, enter the expiry date of
the card.

Currency The currency of the bank account. This defaults to the base currency.

BACS/SEPA If you use Bank Automated Clearing System (BACS) to make

Ref. payments using e-Banking, enter your reference number. The

reference identifies the payer and is included in the payment files.

IBAN Enter the International Bank Account Number (IBAN). This is a
specific format of the bank account number that makes transactions

between European countries easier by reducing errors and delays. An
IBAN is always used in conjunction with a Bank Identifier Code (BIC).

BIC/Swift Enter the BIC number or Swift Code for this bank account. The BIC or
Swift Code, is a way of identifying financial organisations.

If this is your default company bank account, this information appears
under your company name and address on any invoices and orders you
print.

Additional Ref. | Any additional information you have relating to your bank account.

You can enter any text, up to three lines of 60 characters.

Bank Details

Bank name The name of your bank, which can be up to 60 characters.

Address lines You can enter each line of your bank’s address here, up to 60
characters per line.

Contact Details

Email The email address for your bank.

Website The bank's website address.

Contact Name | The contact for your bank account, up to 30 characters.

Telephone The telephone number for your bank, up to 30 characters.
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3.3 Setting the processing date

When you're processing in Sage 50 Accounts the date you use on every transaction is of critical
importance to the accuracy of your data. By default, Sage 50 Accounts uses the date from Windows
as its default date, that is, today’s date.

If you want to change the default processing date, you can do this in

Settings » Change Program Date.

Change Program Date g

Enter a new date to be used as the default for transactions.
This date can be changed at time of posting.

Default Program Date | 31/10/2018] =

| 0K H Cancel |
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3.4 Bank Payments

Introduction

Bank payments are a quick and easy way to record cheque payments, electronic payments or
payments which aren't for a supplier, such as bank charges or loan repayments.

When you post a Bank payment the transaction type changes depending on the bank
account type in the bank record. The payments appear on the audit trail as the following
transaction types:

» BP = Payments from a bank account.
» CP = Payments from a cash account.

» VP = Payments from a credit card account.

To post a bank payment

N.B. Check the program date —change date

Ensure you are in the Bank Accounts module and click the Payments drop down menu
then click Bank Payment. Schools using the suppliers ledger will post supplier payments in
the supplier module.

1. Bank accounts » Payments drop-down » Bank payment > complete the window as

follows:
Bank* From the drop-down list, choose the bank account you want to pay
from.
Date* Enter the date of the payment.
Ref Enter the reference you want to associate with the payment.
N/C* From the drop-down list, choose the required nominal code.
Details Enter the details for the payment.
T/C* From the drop-down list, choose the required tax code.

2. Save » Close.

- . Tip

"‘ 3. If required, you can enter more than one payment at a time.

4. Use F6 to copy the previous column entry and Shift F6 to increase by
1 the previous column entry.

Any payment can be posted to a number of nominal codes for analysis purposes. Only one
line will appear in Bank Activity this is because the same date and reference number was

used when entering the transactions. The activity split can be seen by pressing the Show
Details button. This can be changed from Settings » Bank Defaults, by unticking Group

Bank Transactions.
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E Bank Payments — —
= = et (o= — 1
== = X
d = B KD 2 L)
Clear Print | Insert Remove Copycel Copy cellabove Caladate | Memaorise Recall | Printlist Send to
form | Cheque | row (F7) row (F8) above (F&) +1(Shift +F6) net(F3) Excel
Bank | |

e | |

1800
1800

123456

123457
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3.5 Inter-Bank Transfer

The bank transfer option exists solely to move money between the bank accounts. This
routine is accessed from Bank accounts then Bank transfer

1. Bank accounts » Bank transfer.

2. Complete the Bank transfer window as follows:

From* From the drop-down list, choose the bank account you want to
transfer the money from.

To* From the drop-down list, choose the bank account you want to
transfer the money to.

Payment Amount of the transfer.
Amount

Date* Date of the transfer.
Reference Reference for the transfer.
Description Details of the transfer.

- - Tip:
"~ If required, you can enter more than one payment at a time.

3. Save » Close.

s = T & |@BEeE

Clear Insert Remove Copycell Copycellabove = Memorise Recall Print Send to
form | row (F7) row (F8) above (F6) +1 (Shift +F6) list  Excel

= = =

One Pound Sterling is worth 0 Pound Sterling.

Payment Amount™

1800 11810 |05/05/2015 TRANS | :EankTr_ans_Fer 0 /10000.00|

I v ]

0.00 |

Save

Close
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3.6 Bank Receipts

Bank receipts are a quick and easy way to record one off receipts or receipts, such as
grants, school generated income, voluntary contributions, interest, dividends received, money
received for an insurance claim and other income.

When you post a bank receipt the transaction type changes depending on the bank account type
in the bank record. The receipts appear on the audit trail as the following transaction types:

BR = Receipts from a bank account.
CR = Receipts from a cash account.

VR = Receipts from a credit card account.

LB == % §F H| M@

Clear | Payby Insert Remove Copycell Copycellabove Calculate © Memorise Recall  Printlist Send to
form card row (F7) row (F8) above (F&) +1 (Shift +F6) net {F9) Excel

Bank | Current Account | Tax Rate
NfC | School Tours | Total
|Department™ | Detais
1800 01/11/2016 123 3530 0 belfast 0.00 9 1000.00
0.00 | | 1000.00 |

Save Close

1. Bank accounts > Bank receipt > complete the window as follows:

Bank* From the drop-down list, choose the bank account you want to
receive the money.

Date* Enter the date of the receipt.

Ref Enter the reference you want to associate with the receipt.
N/C* From the drop-down list, choose the required nominal code.
Fund This only appears if you select Enable Charity/Non-Profit in

Settings » Company Preferences » Parameters.

From the drop-down list, choose the required fund.

Details Enter the details for the receipt.

Net Enter the net value of the receipt.

Tip: If you enter the gross value and click Calc, the net and tax
values calculate based on the tax code.
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T/C* From the drop-down list, choose the required tax code.

Tax This automatically calculates from the net value and tax code.

Tip: If required, you can over type this value.

Note: If you've already set up a Sage Pay account, you can use the Pay by Card option to
post the customer’s credit card payment online.

“This information is mandatory

2. Save » Close
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3.7 Recurring Bank Entries

Most schools have regular payments such as standing orders and direct debits. e.g. lease
company payments. To save time and effort in entering the same details again and again
these transactions can be set as recurring entries.

Recurring entries can be set up in Bank accounts module.

Bank accounts/Recuuring items

| E E 25 |

~ Recurring Entry From | To

Bank AfC* 1800 b Current Account

Mominal Code™ 7300 W Leasing Inc Photocopier

~ Recurring Entry Details

Transaction Type |Bar1k,l'Cash,|"Credit Card Payment w |
Transaction Ref
Transaction Details | EMS Copiers |

Department™ Default

~ Posting Frequency

Every® Month{s) Total Required Postings
Start Date™® 08/06/2016 = Finish Date 08/05/2017
Mext Posting Date 08/06/2016 = Suspend Posting 7 ]

Last Posted

Posting Amounts

‘ oK || Cancel |

You can enter recurring entries for daily, weekly, monthly or quarterly time periods and you
can set up customer, supplier, nominal or bank transactions.

= | Note: You must enter recurring journals as pairs of balancing debits and

m credits. If you enter just one side of the journal it results in an error message
on posting the recurring entry, to advise that there is an imbalance in debits
and credits.
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To Set Up a Recurring Entry

1. Bank accounts » Recurring ltems » Add » Complete the Add / Edit Recurring Entry
window as follows:

Recurring Entry From / To

Bank A/C
From or To

Choose the required bank account.

Nominal Code,
Customer A/C
or Supplier
A/C

The Transaction Type determines what appears in this box. Choose
the required nominal code, customer account or supplier account.

Recurring Entry Details

Transaction
Type

Choose the required transaction.

Note: If you choose a journal credit or debit you must set up the
opposite journal with the same amount and posting frequency.

Transaction
Ref

Enter the reference.

Transaction
Details

Enter the details.

Note: This option does not appear if it is a customer or supplier
recurring entry.

Posting Frequency

Every Enter the number for how often you want the recurring entry to be
posted and choose if this is days, weeks or months.
For example, if you enter 1 and choose Months this posts once
every month.

Start Date Enter the date you want the recurring entry to start from.

Next Posting
Date

This automatically calculates the date for when this recurring entry
next posts.

Last Posted

Shows the date for when the recurring entry was last posted. This
is blank if it is a new recurring entry.

Total Required

Enter the total number of postings you want to make.

Postings Note: To set a perpetual recurring entry, leave this at O.

Finish Date This calculates automatically from the start date, posting
frequency and the total required postings.

Suspend Select this option if you want to temporarily suspend the recurring

Posting entry.
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Posting Amounts

Net Amount or | Enter the amount of the recurring entry. If it's a bank recurring
Amount entry enter the net value.

2. Click OK.
To Process the Recurring Entries
1. Bank accounts » Recurring Items > Process.
2. In Show Due Entries Up to, enter the required date » Post.

By default whenever you start up Sage 50 Account the program will check your recurring
entries to see if any are due to be processed. A message will be displayed givin an option
to process them now. Click yes to be taken straight to the recurring entries screen, where
you will then be able to post them. Click no and be taken to the program as normal.

If you forget to process a recurring entry, the program will check back and complete
any entries that have been missed. Therefore never manually post an entry because you
forgot to process it.
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3.8 Bank Reconciliation

It's really important that the transactions in your Sage bank accounts match what has actually
gone through your bank account, so that you know your bank balances are correct. This also

Section 3: Bank Module

helps you to ensure you manage your cash flow effectively.

Sage Accounts has a Reconcile option within the Bank to help you easily match each

transaction in Sage to your bank statements.

To reconcile your bank account

1. Bank accounts » select the required bank account » Reconcile.

2. Complete the Statement Summary window as follows:

Statement Shows the bank account reference, date and statement number.

Reference You can change this to show your own statement reference.

Ending This defaults to the current balance on the selected bank. Enter

Balance the end balance from the actual bank statement you're about to
reconcile.

Statement Enter the end date of the actual bank statement you're about to

Date reconcile.

Interest Earned | If your bank statement shows any interest earned, enter the details

in these boxes.

Account If any bank charges appear on your statement, enter the details in
Charges these boxes.
Statement Summary [ X
Bank : Current Account
Statement Reference : | 1300 2016-06-02 01 |
Ending Balance : | 100457.16 &= Statement Date  |02/06/2018 ©-
Interest Earned :
Amount: 0.0 T | Date:|02/06/2016 | ne: | v|te: (2o |
Account Charges @
Amount:| 0.00 = | Date :|02f06f2016 = | NC : | w | TC: |T2 0.00 w |
OK | | Cancel |

Please ignore the

Interest Earned and
Account Charges
section
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3. Click OK.
The Bank Reconciliation window shows the following:
Statement area
Unmatched items pane
Matched against statement pane
Book Balance
Totals area
Buttons

4. From the unmatched items pane, select and match the transactions to be reconciled. To do
this, either double-click each transaction or select the required transactions » Match.

5. To un match transactions that you have matched in error, from the matched against statement
pane either double-click each transaction or select the relevant transactions > Un match.

6. To post an adjustment > Adjust > select the adjustment type you want to post » OK > enter
the transaction details » Save > Close.

7. The Save option enables you to save the reconciliation part way through and reopen it
later

8. Once you have matched everything to your bank statement > print the report >
Reconcile.

9. |If the value of the matched transactions is not the same as the statement end balance
the Reconciliation Difference window appears, and you can either:

Add Select the adjustment type you want to post » OK » enter the
Adjustment transaction details » Save » Close.

Ignore This option flags all of the transactions in the matched against
Difference statement pane as reconciled.

Cancel To return to the Bank Reconciliation window, click Cancel.
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&fa Reconcile - 1800 - Current Account = | = 52|

@ B = K

Wiew Report | Printlist Send to
history Excel

Statement reference |1800 2016-06-17 01 .f| End date | 17/06/2016 13 End balance 10045716 &

Un-matched transactions

Mo. |T"!'|:IE |.I'J.|: count L | Payments | Receipts |E|r|:
31/01/2015 180 1D septjan  sepi-jan 2015 39545.24
28/02/2015 297 BP February 2015-2019 50.00 5
28/02/2016 298 BP February 2015-2020 62.73 p—
28/02/2015 300 BP February 2015-2023 19729
28/02/2016 301BP February 2015-2024 230.00
28/02/2016 303 BP February 2015-2026 345,90
28/02{2016 304 BP February 2015-2027 431.89
28/02/2015 305 BP February 2015-2028 452.25
28/02/2015 306 BP February 2015-2029 454,00
28/02/2016 307 BP February 2015-2030 500,00
28/02{2015 308 BP February 2015-2031 542.60
28/02/2015 309 BP February 2015-2032 710.45
28/02/2016 311 BP February 2015-2034 755.87
28/02/2016 312 BP February 2015-2035 819.60
28/02/2016 313 BP February 2015-2038 900.00
28/02/2015 314 BP February 2015-2037 926,12

Match ==
teference  |Details 3

28/02/2016 299 February 2015-2022 124.64 25771.50

Matched transactions

Book Balance Total Payments  Total Receipts Matched Balance — Statement Balance =Difference
10045?.15| | 1254.50 | | 0.00 | 25771.50 | | 10045?.16| | -74685.66 |
| Save progress || Recondile || Close |

The Bank Reconciliation Report can be printed
a. Before you press the reconcile the icon you can print the reconciliation report
or

b. Once you have reconciled the account you can go Bank accounts » select the
required bank account » Reconcile and go to the reconciliation screen and print the
reconciliation report.
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3.9 Bank Reports

Print the bank reports for all bank, credit card, debit card and cash accounts at end of each
month and file in Bank File reports.

1. Bank Payments

2. Bank Receipts

3. Unreconciled Bank Transactions
4

Bank reconciliation report —print within Bank Reconciliation section

Date: 02/06/2016 FSSU SAGE 50 Page: 1
rimes a2t Bank Reconciliation
Bank Ref: 1800 Date To: 02/06/2016
Bank Name: Current Account Statement Ref: 1800 2016-06-02 01
Currency: Euro
Balance as per cash book at 02/06/2016: 100.457.16
Add: Unpresented Payments
Tran No  Date Ref Details €
329 28/02/2016  February  2015-2055 5,144.50
333 28/02/2016  February 2015-2060 7,154.63
335 28/02/2016  February  2015-2062 9,653.26
337 28/02/2016  February  2015-2064 15,792.50
338 28/02/2016  February  2015-2065 19,737.31
57,482.20
Less: Outstanding Receipts
Tran No  Date Ref Details €
339 28/02/2016  February  2015-2016 0.54
353 28/02/2016  February  2015-2033 25.00
359 28/02/2016  February 2015-2040 32.00
(57.54)
Reconciled balance : 157,881.82
Balance as per statement : 157 881.82
Difference : 0.00
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3.10 To Cancel Old Cheques

If you have made a mistake, such as entering a cheque from or to the wrong account,
or if you have entered a cheque against the wrong invoice, correct these in the
Transactions module.

Cancel old outstanding cheques.

* Make a list of the cheques that need to be cancelled. The list should state the cheque /
payment reference, payee, amount and nominal code.

* Go to Bank Accounts » Bank Receipt

*  Select the bank account

*  Enter the details of each payment on the cancel list and save.
*  Go to Bank Accounts » Reconcile

*  When reconciling the bank account match the outstanding cheques to the receipts
entered above.
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4.1 Introduction

You can use the Nominal codes module to customise Sage Accounts and make management
reports and transactions more relevant to your school. It's also a great place to see
information about the transactions affecting specific nominal codes.

Within the Nominal codes module you can access your chart of accounts, edit nominal
codes and post journals.

New Opens a blank nominal record, where you can:
Create a nominal account record.
Open an existing nominal account record to view or edit. To do this,
from the N/C drop-down list » choose the required nominal record.
Edit Opens the selected nominal record to view or edit.
Wizard Opens the New Nominal window.
Activity Opens the Activity window.

Journal Entry

Opens the Journal Entry window.

Journal DO NOT USE see section on reversing journals 4.6
Reversal

Prepayments Opens the Prepayments window.

Accruals Opens the Accruals window.

Budgets Opens the Budgets window.

Chart of Opens the Chart of Accounts window.

Accounts

Trial balance

Use this option to run a Period Trial Balance Report.

You can use this report to check the balances on your nominal codes
and ensure that the debt and credit values are equal.

Profit & loss

Use this option to run a Profit & Loss Report.

This report details whether or not your organisation is trading
profitably.

Balance sheet

Use this option to run a Balance Sheet Report.

This report details your company assets and liabilities, and provides a
summary of your current financial position.

Comparative

Use this option to run a Comparative Profit and Loss Report.

profit & loss This report compares actual profit and loss values for a period with the
budget or prior year values.
Variances Generates the Budget Report.

Identifies variances between your budget figures and your actual
figures.
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Prior year Use this option to run a Prior Year Report.
This report compares the current trading activities to the same period
last year.

Delete Deletes the selected nominal code.

Expand all Expands out the tree view so all of the codes are visible

Collapse all Collapses the tree view so only the main categories are visible,

Print list Prints the list of nominal codes.

Tip: If you have a filter applied to the list, the Print list option only
prints the filtered nominal codes.

Send to Excel

Sends the list of nominal codes to Excel.

Tip: If you have a filter applied to the list, the Send to Excel option
only sends the filtered nominal codes.

Reports Opens the report browser for the Nominal codes module.
List Changes the display of your nominal codes.
Analyser Changes the display of your nominal codes.

The Analyser view displays your nominal codes as a simple list without
any grouping or filters applied. The debit and credit columns display
cumulative totals for the current financial year, including any brought
forward values.
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4.2 FSSU Chart of Accounts - Nominal Groups

Nominal Codes
1000-9999

[

I

l

Income & Expenditure
3000-3899
4000-9999

Balance Sheet

[

l

l

Income
3000-3899

Expenditure
4000-9999

Fixed Assets
1400-1699

Department Grants
3000-3299

Education Salaries
4000-4299

Current Assets
Debtors and Prepayments
1700-1799

School Generated Income
3300-3599

Education Other
4300-4999

Current Assets
Bank accounts

1800-1899
Other Income Repairs Maintenance & Current Assets
3600-3899 Establishment Cash Accounts
5000-5999 1900-1999

Administration

Current Liabilities

Creditors
6000-6999 2000-2100
_ ] Current Liabilities
Financial Accruals
7000-7999 2101-2599

Depreciation
8000-8999

Long Term Liabilities
Term Loans
2600-2699
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FSSU - Chart of Accounts

Section 4: Nominal Module

Account No. Description Type Category
1400-100  Capital: Land & Buildings Fixed Asset Fixed Asset
1410-100 Capital: Depreciation: Land and Build. Fixed Asset Fixed Asset
1420-100 Capital: Furniture, Fittings Fixed Asset Fixed Asset
1430-100  Capital: Depreciation: Fixtures and Fittings. Fixed Asset Fixed Asset
1440-100 Capital: Motor Vehicles Fixed Asset Fixed Asset
1450-100 Capital: Depreciation: Motor Vehicles Fixed Asset Fixed Asset
1460-100  Capital: Computer Equip Fixed Asset Fixed Asset
1470-100 Capital: Depreciation Computer Equip. Fixed Asset Fixed Asset
1480-100  Capital: Other Fixed Asset Fixed Asset
1490-100  Capital: Depreciation Other Fixed Asset Fixed Asset
1700-100 Sales Ledger Control Current Asset Debtors & Prepayments
1720-100 Prepayments Current Asset Debtors & Prepayments
1800-100  Current Account Bank Wizard Complete Details
1810-100 Deposit Account Bank Wizard Complete Details
1900-100  Petty Cash A/c Cash Complete Details
1950-100  Cash Control Account Cash Complete Details
2100-100 Purchase Ledger Control Current Liability Creditors
21056-100 School Income Received in Advance Current Liability Accruals
2150-100 Grants Received in Advance Current Liability Accruals
2200-100  Net Wages Control Current Liability Accruals
2230-100  PRD Control Current Liability Accruals
2250-100 PAYE/PRSI Control Current Liability Accruals
2260-100 VAT Control Account Current Liability Accruals
2270-100 RCT Control Account Current Liability Accruals
2300-100  Creditors Current Liability Accruals
2310-100 Bank Loans Current Liability Accruals
2320-100 Loan Current Liability Accruals
2330-100  Leasing Current Liability Accruals
2440-100 Accruals Current Liability Accruals
2600-100  Suspense Account Current Liability Accruals
2700-100  Retained Profit Capital & Reserves  Retailed Profit
2710-100 Profit Brought Forward Capital & Reserves  Retained Profit
3010-100 Capitation Income Department Grants
3020-100  DEIS Grant Income Department Grants
3050-100  Support Services Grant Income Department Grants
3100-100  Secretarial Grant Income Department Grants
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Account No. Description Type Category
3130-100 Caretaker Grant Income Department Grants
3150-100 Book Grant Income Department Grants
3170-100 Special Subject Grant Income Department Grants
3190-100 Home Economics Grant Income Department Grants
3200-100  Transition Year Grant Income Department Grants
3210-100 Leaving Cert Applied Grant Income Department Grants
3220-100  Grant for Traveller Students. Income Department Grants
3230-100 Computer / IT Grant Income Department Grants
3240-100 Supervision/Substitution Income Department Grants
3250-100 Substitute Teachers Income Department Grants
3265-100  SEC Exam Income Income Department Grants
3270-100 Home School Liaison Grant Income Department Grants
32756-100 DEPARTMENT GRANTS Minor Works Grant- Non Income Department Grants
Capital

3290-100  Other DEPARTMENT GRANTS - Specify Income Department Grants
Account No. Department Grants Type Category
3300-100 Fees (Fee Paying Schools) Income School Generated
3310-100 Transition Year Students Income School Generated
3330-100  Book Rental Receipts Income School Generated
33356-100  Classroom Books Income School Generated
33560-100  Hall Rental Income Income School Generated
3370-100 Locker Receipts Income School Generated
3375-100 Journals & Year Book Income Income School Generated
3390-100  School Administration Charges Income School Generated
3410-100 Adult Education Income Income School Generated
3420-100  Canteen Income Income School Generated
3430-100  Tuck Shop Income Income School Generated
3440-100  Uniforms Income School Generated
3450-100 Religion - Retreats etc Income School Generated
3490-100  Study Income School Generated
3495-100 Mock Exam Income Income School Generated
3500-100  Games Income School Generated
3510-100 Bus Income Income School Generated
35620-100  School Musical/drama Income School Generated
3630-100  School Tours Income School Generated
3636-100  Student Insurance Income School Generated
3550-100 Reimbursable Income Income School Generated
3570-100 Other School Generated In Income School Generated
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Account No. Department Grants Type Category

3650-100  Vol. Subs / Registration Income Other Income
3700-100 Parents Councils / Assoc. Income Other Income
3750-100 Fund Raising Income Other Income
3770-100 Insurance Claim Income Other Income
3800-100  Bank Interest Received Income Other Income
3840-100  Amortisation of Grants Income Other Income
3850-100  Other Special Income Income Other Income

3900-100  DES Building Grant

Capital & Reserves

Contribution Fixed Assets

3905-100  Acc. Amortisation Building Grant

Capital & Reserves

Contribution Fixed Assets

3920-100  DES Equipment Grants

Capital & Reserves

Contribution Fixed Assets

39256-100  Acc. Amortisation Equipment Grants

Capital & Reserves

Contribution Fixed Assets

3940-100  DES Building Fees

Capital & Reserves

Contribution Fixed Assets

3960-100  Fund Raising -Fixed Asset

Capital & Reserves

Contribution Fixed Assets

3980-100 Parents Cont. Fixed Asset

Capital & Reserves

Contribution Fixed Assets

4110-100 Substitute Teachers

Expenditure

Education Salary

4111-100 Privately Paid Teachers

Expenditure

Education Salary

4130-100 Teachers' Salaries

Expenditure

Education Salary

4150-100 Supervisors Salaries

Expenditure

Education Salary

4155-100 State Exam Aides Grant Salaries

Expenditure

Education Salary

4170-100 Adult Education

Expenditure

Education Salary

4190-100 Study Expenditure Education Salary
4191-100 PAYE/PRSI Education Salaries Expenditure Education Salary
Account No. Description Type Category

4310-100  Teaching Aids Expenditure Education Other
4330-100  Religion Expenditure Education Other
4350-100  Art Expenditure Education Other
4370-100  Home Economics Expenditure Education Other
4390-100  Science Expenditure Education Other
4410-100 Computers / IT Expenditure Education Other
4430-100  Woodwork / Building Cons Expenditure Education Other
4450-100  Metalwork / Engineering Expenditure Education Other
4470-100 Technology Expenditure Education Other
4490-100  Other Subjects - Specify Expenditure Education Other
45650-100  Leaving Cert Applied Expenditure Education Other
4570-100  LCVP Expenditure Education Other
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Account No. Description Type Category

4590-100  Transition Year Expenditure Education Other

4610-100 Learning Support Expenditure Education Other

4620-100  Teacher Inservice & Training Expenditure Education Other

4630-100  Career Guidance Expenditure Education Other

4640-100 Library Expenditure Education Other

4650-100  Physical Education Expenditure Education Other

4670-100 Games (excl. travel) Expenditure Education Other

4671-100 Games Travel Expenditure Education Other

4690-100  Bus Hire Expenditure Education Other

4710-100 School Tours Expenditure Education Other

4720-100 School Musical/Drama Expenditure Education Other

4730-100 School Books Expenditure Education Other

4750-100 Mock Examination Fees Expenditure Education Other

4770-100  Trophies & Prizes Expenditure Education Other

4810-100 Home / School / Liaison Expenditure Education Other

4850-100  Student Council Expenditure Education Other

4910-100 Other Educational Expense Expenditure Education Other

5010-100  Caretaker Wages Expenditure Repairs, Maintenance & Establishment
5030-100 Caretaker Pension (School Cont) Expenditure Repairs, Maintenance & Establishment
5031-100 Caretaker PAYE/PRSI Expenditure Repairs, Maintenance & Establishment
5110-100 Cleaner Wages Expenditure Repairs, Maintenance & Establishment
5111-100 Cleaner PAYE/PRSI Expenditure Repairs, Maintenance & Establishment
5150-100 Contract Cleaners Expenditure Repairs, Maintenance & Establishment
5170-100 Cleaning Materials Expenditure Repairs, Maintenance & Establishment
5310-100 Repairs-Buildings/Grounds Expenditure Repairs, Maintenance & Establishment
5315-100 Grant Aided Minor Works Expenditure Repairs, Maintenance & Establishment
5360-100  Repairs-Furniture, Fitt, Equip. Expenditure Repairs, Maintenance & Establishment
5400-100  Security Expenditure Repairs, Maintenance & Establishment
5450-100 Insurance Expenditure Repairs, Maintenance & Establishment
5510-100 Heating Expenditure Repairs, Maintenance & Establishment
5550-100 Light and Power Expenditure Repairs, Maintenance & Establishment
5610-100 Rent and Rates Expenditure Repairs, Maintenance & Establishment
5700-100  Licence Fee to Trustees Expenditure Repairs, Maintenance & Establishment
5800-100  Other Repairs &Maintenance. Expenditure Repairs, Maintenance & Establishment
6010-100 Secretarial Wages Expenditure Administration

6050-100 Secretarial Pension (School Cont) Expenditure Administration

6051-100 Secretarial PAYE/PRSI Expenditure Administration

6100-100 Staff Recruitment Expenditure Administration
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Account No. Description Type Category
6150-100 Advertising / Public Relations Expenditure Administration
6210-100 Postage Expenditure Administration
6260-100  Telephone Expenditure Administration
6300-100  Printing & Stationery Expenditure Administration
6305-100  Photocopying Expenses Expenditure Administration
6350-100  Office Equipment Expenditure Administration
6400-100  Accounting / Auditing Fee Expenditure Administration
6450-100  Other Professional Fees Expenditure Administration
65600-100  Travel & Subsistence Expenditure Administration
6600-100  Principal's Expenses Expenditure Administration
6650-100  Board of Management Expenses Expenditure Administration
6700-100  Annual Subscriptions Expenditure Administration
6730-100  In-School Administration Sys Expenditure Administration
6750-100  Donations / Charity Expenditure Administration
6755-100 Medical and 1st Aid Expenditure Administration
6780-100 Staff Room Expenses Expenditure Administration
6800-100  Hospitality Expenditure Administration
6830-100  School Tuck-shop Expenditure Administration
6860-100  School Canteen Expenditure Administration
6900-100  Other Administration Expenses Expenditure Administration
7300-100 Leasing Including Photocopier Expenditure Financial
7320-100 Loan Charges Expenditure Financial
7350-100 Fund Raising Expenses Expenditure Financial
7400-100 Bank Interest Paid Expenditure Financial
7450-100 Bank Charges Expenditure Financial
7800-100  Reimbursable Expenses Expenditure Financial
8000-100  Annual Depreciation - Buildings Expenditure Depreciation
8020-100  Annual Depreciation Furniture Fit Expenditure Depreciation
8040-100  Annual Depreciation Motor Vehicle Expenditure Depreciation
8060-100  Annual Depreciation Computer Equip. Expenditure Depreciation
8080-100  Annual Depreciation - Other Expenditure Depreciation
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4.3 Creating New Nominal Codes

To create a new nominal code go to Nominal Codes » Wizard and this opens New Nominal

Window.

1. Enter the nominal account details as follows:

Name

The name of the nominal account, up to 60 characters.

Tip: This appears on all financial reports.

Type

The area you want to assign the nominal account to.

A nominal account is assigned to a specific area in the profit and
loss or the balance sheet.

By default, these areas cover:

* Income and Expenditure: Des income, School Generated
Income, Other Income Education Salaries, Education Expenses,
Repairs and Maintenance, Administration Expenses and
Financial Expenses.

» Balance sheet: Fixed Assets, Current Assets, Current Liabilities,
Long Term Liabilities and Capital & Reserves.

Category

The account category for your new nominal account.

Each area in the Income and Expenditure or balance sheet is
divided into category accounts, which appear as headings on all
financial reports.

N/C*

A unique reference code used to identify the nominal account. You
can't change this once you save the record.

The code must be numbers only and have at least four digits and
no more than eight, between 0001 and 99999999,

We recommend:

» The number of digits in a code are consistent. For example, you
can't have some with four numbers and others with six.

* You allocate a code so that the nominal account groups with
associated accounts. For example, group all your income nominal
accounts within a range. This ensures the nominal account is
included and used in the correct financial report.

* This information is mandatory.
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2. Next » to create a nominal account with no opening balance select No, there is no

opening balance to enter » Create. To create a nominal account with an opening

balance, select “Yes, | wish to enter an opening balance” > enter the opening balance

details as follows:

(=] Note: Entering opening balances covers a number of activities that are

m done in a set order. Unless you are familiar with opening balances and the
process involved, we recommend you don't enter an opening balance at
this point.

Type*

Choose the transaction type associated with the opening balance:

Debit balances usually include fixed assets that aren’t overdrawn,
purchases and overhead accounts such as electricity charges.

Credit balances usually includes loans and income accounts such
as sales.

Date*

Enter the date that you want to use for the opening balance.

Tip: It should match the last day of your previous accounting
period.

Reference

O/Bal is a standard reference and helps to identify opening
balance transactions on the audit trail. You can change this if
necessary.

Amount*

Enter the gross amount of the opening balance.

* This information is mandatory.

3. Click Create

Mew Nominal

Enter Details
Opening Balance

Nominal Information

Enter Details 6

To create a new nominal account, you need to enter the nominal accounts name and select the type
of nominal account that you are creating,

The new nominal account can be given a category within the chart of accounts and a unique reference
code to identify the account.

MName ‘ School Uniforms ‘
Type ‘ Income ¥ ‘
Category School Generated Income M
e

Cancel
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Amending a Nominal Code

List the nominal codes and select the code you want to amend and click the new/edit drop-
down. You can amend the name, budget figures and prior year figures at any time however
the code numbers cannot be changed once created.

Deleting a nominal code

List the Nominal Codes and select the code you want to delete and from the toolbar click
Delete

You cannot delete an account if any of the following apply:
*  The account has a balance
* The account has a transaction history

* The account is reserved as a Control Account.
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4.4 Entering a Nominal Journal

You can use journals to transfer balances between nominal codes. You can also use journals
to correct balances as they don't affect customer or supplier accounts.

Journal transactions are always posted with an equal value in the Debit and Credit columns,

with at least one journal debit and one journal credit per journal posting.

To post a journal
1. Nominal codes » Journal entry.

2. Check or enter the following information:

Reference A reference for the journal, up to 30 characters.

Posting Date The date you want to post the journal.

Balance This is the difference between the debit and credit values for the
journal.

Tip: Before you can save the journal the balance must be zero.

N/C* The nominal account code you want to affect this part of the
transaction.

Name The name of the nominal account code you have entered.

Ex. Ref An additional reference to further identify the journal, up to 30
characters.

Department - The department number for the transaction.

Details A description for the transaction, up to 60 characters.

T/C* The appropriate tax code for the transaction.

Debit Enter any debit value here.

Credit Enter any credit value here.

* This information is mandatory.

3. Repeat step 2 until you've entered all the lines of the journal » ensure the debit and
credit values match.
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4. Complete the Journal Entry window by clicking one of the following options:

Save Save the journal and create the transactions.
Discard Clear the information you have entered.
Print List Print the journal.
To Excel Sent the information to an Excel spreadsheet.
Close Close the Journal Entry window.
=" Journal En
A EE Y W | Ed
Clear Insert Remove Copycell Copycelabove | Memorise Recall | Printlist Send to
form | row (F7) row (F8) above (F6) +1 (Shift +Fg) Excel
Reference Posting Date Balance
| [17r08/2016 = |
|Name |Details Jc* Debit|
1400 Capital: Land & Buildings |New extention e i 100000.00 | 0.00|
i AE B B Eip st L 1 L doseqedy
100000.00 | 100000.00 |
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4.5 Posting RCT and VAT Journal

Introduction

School Boards of Management are principal contractors for the purposes of RCT as schools
fall within the definition as defined by legislation “any board or body established by or under
statute ... and funded wholly or mainly out of funds provided by the Oireachtas”.

School Boards of Management can be involved in a range of activities including:
Construction Projects, Summer Works, Emergency Works, Major Devolved Projects,
Additional Accommodation Schemes as well as day to day repairs that bring them within the
scope of Relevant Contracts Tax (RCT) and, as a consequence, Value Added Tax (VAT).

Posting to Sage Accounts

Journal entries will be used to process the RCT and VAT.

Example

Mr Joe Bloggs paints the school for €10,000 and gives an invoice to the school excluding VAT.

c. The school enters the details on ROS (Revenue Online System)and ROS notified the
school to deduct RCT.

RCT @ 20% =€10000 * 20% = €2000
d. The school pay Mr. Joe Bloggs €8,000 (€10,000 - €2,000)

e. The school as Principal Contractors must pay the VAT to the Revenue and the VAT is
Reverse Vat @13.5% =€10000713.5% = €1,350
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Enter the payment on SAGE using Bank Accounts/Bank Payment

Bank | Current Account |
NjC

| Repairs - Building/Grounds |

|Date=

aang L0015

=5 = c=L =
== =)
1 = k= 3 T
Clear Print Insert Remove Copycell Copy cellabove Caloulate | Memorise Recal | Printlist Send to
form | Cheque | row (F7) row (F8) above (F&) +1 (Shift +F&)

net (F3)

Excel

Total 8000.00

|Department* |Details

P loe Bloggs.

8000.00 9

5000.00 | [ 0.00

2. Enter the RCT and Vat liability using a Nominal Journal.

Nominal codes/Journal entry

|Name

= = = = =
llEE % " @™ 2
Clear Insert Remove Copycel Copycellabove | Memorise Recall | Printlist Send to
form | row (F7) row (F8) above (F&) +1 (Shift +Fg) Excel
Reference Posting Date Balance
| o 7]

|Details

Debit| Crex
2270 RCT Control Account Joe Bloggs Inv 45 T 0.00 2000.00
2260 VAT (;oniml Account Joe Bloggs Inv 45 T2 0.00 1350.00
5310 Repairs - Building/Grounds |Joe Bloggs Inv 45 T2 3350.00 0.00
3350.00 | 3350.00 |
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To verify the balances owing to Revenue for RCT and VAT go to Nominal Codes/

Activity. Enter the nominal code ,the date range and run the report.

€5 Activity == % |
= L]
E
View Printlist Send to
item Excel
[2260 | [VAT Control Account |
Show: Date: | 01/01/1980 to 31/12/2059 Type: | all Trans:[1w3ed |
Mo # |Type |Date |Ref. |Ex.Ref. | Dept|Details | Amount | Credi
3631C  31/01/2016 0 Joe Bloggs Inv 45 1350.00 1350.00
0.00 | 1350.00
Balance: 1350.00
R > »

RCT: The entries in the RCT Nominal account 2270 must be verified to the Revenue
Deduction summary each month and the agreed amount will be settled via ROS on
the 23rd of the following month. The payment is entered using Bank Accounts/Bank

Payment to nominal code 2270.

VAT: The entries in the VAT Nominal account 2260 must be checked and the balance
due entered on the VAT 3 form on ROS and the amount settled with the Revenue on
a bi-monthly basis. The payment is entered using Bank Accounts/Bank Payment to

nominal code 2260.
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4.6 Entering Reversing Journals, Accruals and
Prepayments

WARNING: THE JOURNAL REVERSAL ICON ON THE TOOLBAR
DELETES JOURNALS THEREFORE IT SHOULD NOT BE USED FOR
ENTERING REVERSING JOURNALS

To enter reversing journals, accruals and prepayments please use
the normal journal entry and click Reverse Journal.

To activate this this feature, select Settings » Company Preferences » Parameters tab:

| e

Company Preferences \ )

Accountant | Budgetin VAT Sage Pay
Details | Labels Reporting

Call Charges

Default call charge rate

Transaction Processing

[¥]Display Account Status
When I place an Account on Hold
{")Show a warning on each change

(®)5top the Account
Others
[(JExdude deleted transactions [#]Login Check
[#]Display ActiveSearch Popup [IMo Recurring entries at startup
[#] Access Rights []Enable Project Costing
[[Jallow Negative Stock [CJEnable CharityMon-Profit options
[#]Copy skeleton journal values [¥]Enable Smart Totals
[ Timeslips Link [#]Log Events
[“]Enable Reversing Journals [Jrause outside Finandal Year message

[ o= ]

When entering a reversing journal check the box at the bottom of the window and specify a
date for the reversal. This enables SAGE to post both journals at the same time.
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Departments can be created through Departments in the toolbar. Select Modules »
department and select a department to edit and click on the Edit button. The department

can be given any name up to sixty characters.

epartment Record

-

Print list

Details

Memo

Reference 10

Mame GAMES - SOCCER

Hotes

Record 1of 1

Every transaction entered on Sage 50 has a department reference. The default

department is 0.

Department Activity

When transactions have been posted, you can view the department Activity within the

Department Module:

No. 4 |Type
365 BP

|Date
31/01/2016

|Account

|Details

4670 referree

" o - " = =5 X
Activity 1 = .' ’ —TET X
—

X
F
Printlist Send to
Excel
Department | GAMES - S0CCER
Show: |Custom Range... v Date: | 01/01/1980 to 31/12/2093 Type: | | Trams.:| 1o 365

50.00

Record 1of 1

Close

To run a department report
Departments > Reports.

W~
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4.8 Microsoft Excel

Almost all screens in Sage 50 Accounts can be sent directly to Microsoft Excel by selecting
the Send to Excel button. If the “To Excel” button is not directly on the screen, you can

still export it to a spreadsheet by selecting File » Microsoft Integration > Contents to
Microsoft Excel.

To export the data as a report:
1. Open the required module, for example Transactions » Reports.
2. Open the required reports folder, for example Audit Trail > select the required report,

3. Select export to Export » complete the Save As window as required » Save » OK
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5.1 Introduction

This section covers how to record supplier invoices and credit notes and their effect on the
purchase and nominal ledgers. The Supplier module is used to record information about
suppliers, such as contact details, credit facilities and invoices received and paid for. A
supplier can be either a company or a person you purchase goods and services from. In
addition, payments in full, part payments, allocating credit notes, paying on account and
printing remittance advices will also be covered. If you are using the Supplier module in
TAS please contact the FSSU for details to set up the suppliers in Sage 50.
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5.2 Creating a

New Supplier

Supplier record wizard

When setting up supplier records, you need to collect a lot of information. Using this wizard
helps you record everything that's required. The Supplier record wizard captures key details
for a supplier which are added to a unique record. After completing the wizard take a look at
the record which includes other settings you may find useful.

To open the wizard » Suppliers » New/edit » Wizard.

° Credit Details
o Bank Address
° Bank Account
° Opening Balance

MNew Supplier |__§3 |
Supplier Information
488 Supplier Details Supplier Details 9
B To create a new supplier account you need to enter the supplier's name and a unigue
o Contact Details i
o SupplierDefauls Name® | New Supplier Account
crer ]

Please enter the supplier's address.

Streetl
Street2
Town
County
Post Code

Country Ireland IE v

Cancel

Supplier’s
Trading Name

A unique reference code used to identify the supplier. It can include
letters or numbers or both, for example SMITHOT, but you can't change
this once you save the record.

A/C Ref*

Your suppliers are listed in the Suppliers window and by default they're
sorted by this code.

As you begin typing text in the Name box, a reference code is
suggested for you. You can change this reference code if you want.

Address

Use the Street1, Street2, Town, County and Post Code lines to enter
your supplier's address.

The address is used in documents you may want to print and send to
your supplier such as invoices and letters.

Country

The suggested country is based on your regional settings in Windows.
From the drop-down list choose the country where the supplier is
based.
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Telephone

number

Fax Record a fax number.

Emaill The email address you expect to use most often when emailing this
supplier.

Website The supplier's website.

Contact Name

The person responsible for the account, though you can use this box
to hold any other related information.

Trade Contact

The person you contact if you have a query about an order.

VAT Number If you're VAT registered, enter the VAT Registration Number for this
supplier.

Accounts Select the status that applies to this account. When creating an

Status account, the status Open is used by default.

Nominal Code

This is the nominal account you expect to use most often for any
purchase transactions with this supplier.

When you record an invoice, credit or purchase order this nominal code
appears, although you can change it at that point.

Credit Limit The amount of credit given to you by your supplier. Once you exceed

the limit, warnings appear when you work with the account.
Settlement If the supplier gives you a discount for early payment, enter the number
Due Days of days you have to pay within to qualify for the discount.

Payment Due
Days

Enter the number of days in which payment is due for outstanding
invoices.
If a payment is not made during this time, the invoice is flagged as

overdue.

Terms Enter the terms agreed with the supplier.

A/C Opened The date the supplier account was opened. This information can show
you how long the supplier has been trading with you.

Next Credit The date your credit terms with the supplier are due for review.

Review

Bank Name The name of the supplier’s bank.

Address The supplier's bank address.

Account Name

The name of the supplier’s bank account, for example J Smith & Sons.

Sort Code

The supplier's bank’s sort code.lf you intend to make electronic
payments to the supplier, using E-banking, you must enter the
supplier's bank sort code.
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Account No The supplier's bank account number. If you intend to make electronic
payments to the supplier using e-Banking, you must enter the
supplier’s bank account number.

BACS/SEPA Enter the BACS/SEPA reference here.

Ref This is used for making e-Banking payments.

Online If you intend to pay this supplier using e-Banking, select this check

Payments box.

IBAN If required, enter the supplier’s International Bank Account Number
(IBAN).

An IBAN is always used in conjunction with a Bank Identifier Code
(BIO).
BIC/Swift If required, enter the BIC number or SWIFT code for this supplier's

bank account. The BIC or SWIFT code is a standard identifier for
banks and should be used for all international payments.

This number is validated when you enter it in the record.

Additional Ref

Use this box to enter any additional information you have received
about this supplier’s bank account.

Payment
Method

From the drop-down list, choose the preferred payment method agreed
with this supplier.

Several payment methods are available as follows: BACS/SEPA, Cash,
Cheque, Credit Card, Direct Debit (DD) or Standing Order (SO) and
Other.
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5.3 Setting the processing date

When you're processing in Sage 50 Accounts the date you use on every transaction is
of critical importance to the accuracy of your data. By default, Sage 50 Accounts uses the
date from Windows as its default date, that is, today’s date.

If you want to change the default processing date, you can do this in:

Settings » Change Program Date

Change Program Date |__EE |

Enter a new date to be used as the default for transactions.
This date can be changed at time of posting.

Default Program Date  [31/01/2015 |

| 0K || Cancel |
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5.4 Supplier Invoice & Credit Notes

To keep track of what you owe to your suppliers you need to record all invoices and credits

you receive. Batch invoicing is a quick, simple procedure where you can enter purchases from

your suppliers line by line.

1. Suppliers » Batch invoice.

2. For each invoice item, or whole invoice, enter the details one line at a time.

~ - Tip:
'Q~ To insert a line, use function key F7 or to delete a line use F8.

Enter the account reference of the required supplier or choose it
from the drop-down list. To create a new supplier record, from the
drop-down list, click New.

Date*

The current software date appears automatically. If you want to
change this, either enter the new date or use the calendar button.

If you have lots of invoices to enter, all with the same date, in
Settings » Change Program Date you can set the software date to
the date you require.

Ref

If required, you can enter a reference to help you trace your
invoices easily. This is the reference that appears on your reports.

Ex Ref

If required, enter an additional reference here. For example, you
could enter the order number that the supplier has entered on the
invoice.

N/C*

Choose the nominal ledger account code to post the net value of
the invoice to.

The supplier's default nominal code appears automatically. If you
want to change this, choose a new code from the drop-down list or
manually enter it.

Department -

To assign this transaction to a specific department, enter a
department number.

Details

You can enter up to 60 characters of text to identify the invoice
entry.

3. Save » Close.

Supplier credit note posting

1. Suppliers » Batch credit.

9. For each credit item, or whole credit, enter the credit details one line at a time.
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A/C*

Enter the account reference of the required supplier or choose it from
the drop-down list. To create a new supplier record, from the drop-down
list, click New.

Date*

The current software date appears automatically. If you want to change
this, either enter the new date or use the calendar button.

If you have lots of invoices to enter, all with the same date, in Settings
» Change Program Date you can set the software date to the date you
require.

Credit No

If required, you can enter a reference to help you trace your credit notes
easily. This is the reference that appears on your reports.

Ex. Ref

If required, enter an additional reference here.

N/C*

Choose the nominal ledger account code to post the net value of the
credit to.

The supplier's default nominal code appears automatically. If you want
to change this, choose a new code from the drop-down list or manually
enter it.

Department* -

To assign this transaction to a specific department, enter a department
number.

Fund

If your company has a charitable status and you've created fund
records, you can associate the credit with an existing fund.

From the drop-down list choose the required fund.

Details

You can enter up to 60 characters of text to identify the credit entry.

Net*

Enter the net value of the credit. If you prefer, you can enter the gross
amount, including VAT, and then click Calculate net (F9). The value is
then split between net and VAT using the tax rate applied to the tax
code.

T/C*

The default tax code for this supplier automatically appears.

If you want, you can enter any of the other tax codes defined in your
VAT rate table.

VAT*

Displays the amount of VAT calculated by applying the tax code entered
to the net amount. If required, you can change this value.
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3. Save » Close.

Section 5: Supplier Module

|E aten Suppliermoig

B - B 3 (= =] % ]
= == = == fet
— j e X
l =5 3 i 2 = [
Clear | Insert Remove Copycell Copycellabove Calclate | Memorise Recall | Printlist Send to
form | row (F7) row (F8) above (F&) +1(Shift +F6) net (FS) Excel
|Ele|:-artn'u':r|r” Details VA
ADTOOL 131/01/2018 5885 2250 lo Annual fee 2000.00 19 0.00
BOL |31/01/2015 566554464 |s510 0 December bil 1500.00 19 0.00
3500.00 | [ 0.00
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5.5 Supplier Payments

To help you maintain good working relationships with your suppliers it's important that you
pay your invoices on time. The Supplier Payments window helps you easily allocate your
payments to the relevant invoices.

You can see what the oldest outstanding invoices are so that you can clear these invoices

first or you can even spread the payment value over multiple invoices.

To record a supplier payment

2. Bank accounts » Payments drop-down » Supplier payment.

i% Supplier Payment - Current Account SRS
~ =
= X

I g\ = 9 =
Clear = Payin Wizard Automatic | Department | Printlist Send to
form | ful (F3) Excel

Bank AfCRef  [1800 v | Current Account Date* [17/06/2015 | Cheque No. | |
Payee® |ADTO01 ~ | ADT Fire & Security Ltd
Two thousand euro |€ 2000.00 = |
FS5U 03/03/2016
Show |AI\ V| From | L ==| To | (¥ :‘ [CList Invoice/Credit by item line

No. |Type [A/C |Date |Ref |Ex.Ref |Department |Details |Tic | Amount€|Disputed?|  Payment €|

366 P ADTOO1 31012016 (9885 | _rlj'a Annual fee _nfa 2000.00 | | 0.00] 0.00

supplier Balance 2000.00 | Bank Balance 98407.16 Analysis Total 0.00 |

Complete the Supplier Payment window as follows:
Bank A/C Ref Choose the required bank account.
Payee Choose the required supplier account.
Date Enter the date of the payment.
Cheque No. Enter the cheque number or reference for the payment.
Amount box Enter the amount of the payment.
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Show To filter which transactions appear in this window, from the drop-down list

choose one of the following:

* All - Shows all transactions.

* Due - Only shows transactions within their due date. You set the due date
within Suppliers > Supplier Record > Credit Control 3 Payment Due. This
then records on each transaction.

* Date Range - If you choose this option you can then enter the From and
To date which then only shows transactions in this date range.

List Invoice/ To see the individual lines for invoices which have been grouped, select this
Credit by item check box.

line

Payment Enter the required payment value against the relevant invoices.

To allocate credit notes or payments on account, enter the value you want
to allocate on the credit note or payment on account item line then enter the
same value on the invoice item line.

Discount In the Discount column enter any required discount value against the
relevant invoice. You must also reduce the payment value by the discount
value.

3. Save » Close.
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5.6 Supplier Remittance Advices

Remittance advices

To enable this option, ensure a tick is placed to Always Create Remittance from

Settings » Bank Defaults

Bank Defaults

General

[]Enable e-Banking

[(JGroup items in Bank Rec.
[CJList Invoice Credit by item line
[#]Create Bank Recondiliation PDF

Cash register settings

Sales nominal: w
T9 0,00 w

Discrepandies:

Tax code:

|:|No Warning on Visa receipts
Gruup Bank Transactions
[¥]always Create Remittance

[ ]Takings are VAT indusive

| oK

H Cancel |

It is possible to print remittances Bank Accounts » Remittances

E:g Remittance

=S

=0 =l

Swap Clear | Purge

= X

<0 = f

Delete | Printlist Send to
Excel

Bank 1800 3 Current Account
Print
[[Jpate Range From: show printed items[_]
Index No. = |Date |Bank A/C [Cheque  |Supplier A/C |Supplier Name Amount €|Printed? | Items|Email or Print
0000001 01/04/2016 1800 3333 ADVOD1 Advanced Learning 5000.00 N 1 Print
Print Remittances H Close

Select the supplier(s) you want to print remittances for
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[E& Remittance

| New || Edit || Delete H

Run |

(=@ = |
[ — —
=55 %50 a2
Swap Clear | Purge Delete | Printlist Send to
Excel
Bank 1300 v Current Account
Print
[pate Range From: Ll Show printed items [
Tor |17 Remittance Advice Printing = | @& Eg_‘
D ils Layout L
|File Name Output
T . - . ST AL Iw
HOnaRa, 01f04/2016 Remittance Layout - 117 REMIT11.layout Oprintes i
Remittance Layout - A4 REMITA4.layout e
Security Mailer Remittance SecMaiRem.layout @Preview
OFile
(OEmail

Close

Click on the Create Remittance button and choose the required print format.

You can click show printed items if you need to reprint any.
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5.7 E-banking

E-banking enables you to:

Section 5: Supplier Module

Create payment files to upload to your bank in order to pay your suppliers

The bank account through which you wish to conduct e-banking must be connected to the
internet banking service. Sage supports Bank of Ireland and Allied Irish Banks.

Setting up e-banking

E-banking is not enabled automatically; the following steps must be completed:

Select Settings » Bank Defaults and select Enable e-Banking.

Bank Defaults

| & |

General

[#]Enable e-Banking

[Jeroup items in Bank Rec,
[[Juist Invaice/Credit by item line
[¥]create Bank Recondiliation POF

Cash register settings

Sales nominal: w
TS 0.00 w

Tax code:

|:|No Warning on Visa receipts
Group Bank Transactions
[+] always Create Remittance

[Jrakings are VAT indusive

| oK || Cancel ‘

Select the required bank from the Bank Details tab select Bank Type

T Bank Record-Current Account

l P
= Lé
Clear | Delete
form

Account Details

Bank Address
Bank Details

Bank Name

Bank of Ireland

Main Street

Memo
Streetl

Activity Street2
Town
County

Post Code

Contact

Telephane

Email

[
[
Fax [ |
[
[

Website

Account Details

Account Name Ml
Sort Code [0tz | ey [77 7]
ocssepAret [ |
s
1

BIC/Swift
Roll Number

Additional Ref

Click the configure button to configure the settings

You can specify a common directory to store Supplier Payments Files.
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5.8

Supplier Activity Record

This is a great way to view the history of trading between you and your supplier. It shows
your credit limit with them, the balance owed as well as the total amount you've paid and the
expenditure for the year.

A summary of dealings you've had with the supplier appear in a list. Each line in the list
represents a transaction such as an invoice or payment.

To view the activity » Suppliers » double-click the required record » Activity

€5 Activity | = | = 2
- = —
B ® =
View Unallocate Hide Printfist Send to
item detail Excel
Al Balance EUR € 0.00
Name ‘ ADT Fire & Security Lid Amount Paid EUR € 2000.00
Credit Linit ELR € | 0.00] Turnover YTD EUR & 2000.00
Show: [AllTransactions v Dates |0L/01/1980 0 31/12/2099 |  Type: [Al | omsonly [0 Trans: |1t 368
No & |Type |Date |Ref |Detaits | Amount €| ofse| | Debit €|
356 P1 31/01/2015 =885 Annual fee 2000.00 2000.00
368 PP 17/06/2016 Purchase Payment 2000,00 2000.00

No|Type |Date |Ref  |N/C | Dept|ExRef |Detsis |Tax¢| Amount€| Debit€| Credit€| Trans. Balance €
L:._‘ 366 PI 31/01/2016 9885 2260 ] Annual fee 3 2000.00 2000.00 2000.00
HE 17/06/2016 i} 2000.00 from PP ... 2000.00 0.00
Future € Current € 30 Days € 60Days € 90 Days € Older €
.00 | oo | oo | 000 | 00| | 0.00

Record 1 of 1

‘ Close |

To filter the transactions which appear, from the Show drop-down list, choose the criteria
you require.

If you choose Custom Range, a further window appears where you can define a
transaction number range, date range and transaction type. The selections you make
here are shown in the boxes alongside the Show drop-down list.

In the toolbar, you can click the Show detail and Hide detail buttons. Show detail opens
a window breaking down any selected transaction into its component parts. For example,
a purchase payment is broken down into the invoices it paid off, where as a purchase

invoice lists any payments allocated against it. Hide detail closes the window showing the
detailed breakdown.
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5.9 Supplier Aged Balances

Seeing a supplier’s outstanding balances, grouped by the age of the credit, is a useful way of
keeping track of what you owe that supplier and can act as a useful reminder to pay. You can
use the Aged balances option to help you organise required payments and ease your cash
flow.

When you analyse your aged balances, you can enter a date for the report, and you can also
include payments up to a particular date, so you can run the report retrospectively.

To analyse aged balances for suppliers
1. Suppliers » select the required suppliers.
2. Aged balances » enter the dates you require.

The Aged Balances window appears showing each selected supplier. The total of any
outstanding values are grouped by age. The age period is determined by the setting in
the Settings » Supplier Defaults » Ageing. It is either based on calendar months, or is
based on a period of days that you can specify.

The total amount you owe all of the selected suppliers is also shown, grouped by age, in
the total boxes at the bottom of the window.

3. To see the balances in a graphical format » Graph.

4. To see the individual transactions that make up a supplier's aged balances » Aged
Balances » select the supplier from the list 2 Detailed view.

5. If the invoice was created from a purchase order, to view the order » select the required
transaction » View item.

6. To return to the Suppliers window » Close » Close.

Date: 17/06/2016 FSSU 03/03/2016 Page: 1
Time: 10:37.00 Aged Creditors Analysis (Summary)
Report Date: 31/01/2016 Supplier From:

Include future transactions: No Supplier To: yrrrsrrrs
Exclude Later Payments: MNo

** NOTE: All report values are shown in Base Currency, unless otherwise indicated **

AjC Name Credit Limit Turnover Balance Future Current Period 1 Period 2 Period 3 Older

BO1 Bord Ghis € 000 1,500.00  1,500.00 000 1,500.00 0.00 0.00 .00 0.00

Totals: 150006 150000 [ 1,500.00 000 000 o0 0.00
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5.10 Supplier Reports

As part of the month end procedures the following reports should be printed and
filed on a Supplier Report file. The reports are stored as favourite’s in Sage.

1. Daybooks: Supplier invoices detailed

2. Daybooks: Supplier Credit detailed

3. Daybooks: Supplier Payments- print from the Bank Module
4. Aged Creditors detailed
5

Aged Creditors Summary

To print or preview a report, select it and click Print or Preview, then enter the criteria for the
report if appropriate.

Use the criteria to select the range of information that you want in your report;

Supplier invoices
Supplier statements
Top suppliers

Preview a sample report for a specified number of records or transactions (0 forall) |0

S

Help

supplier.

upplier reports

e e

New i m :

—
Sl i e
et Criteria for Day Books: Supplier Invoices (Detailed) L= ]
Daily transactions
Day books Criteria Values
Departmental Enter the values to use for the criteria in this report
EC purchases
My supplier reports Transachon Date: Between finclusive) ~ | 01/01/1580 ~ and 3171272019 ot
Supplier activity T ion No [Bﬂwe&ﬂ linclusive) ‘“1 E_ﬂ and |3889&9@3 H
Supplier contacts Department [Between {inclusive) v”O | and |939 B
Supplier details Nominal Code Between finclusive) ~ and 99999939 i
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Customer Module (Fee Charging Schools Only)

6.1 Introduction

The sales ledger or customer ledger, as it is sometimes known, is very similar in operation
and features to the supplier ledger. The customer’s module in SAGE 50 accounts is used

to record information about customers (students) such as contact details, invoices sent and
paid for. If you are using the Sales Ledger in TAS please contact the FSSU for details to set
up the customers in SAGE 50.
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6.2 Creating a New Customer

You can use the Customer record wizard to enter customer details in a series of steps. The
wizard helps to ensure you enter all of the required information quickly and correctly. Entering
full customer details in the record saves you time when processing transactions.

You can access the wizard through Customers » New/edit drop-down » Wizard

New Customer L2 ]

Customer Information

8 Customer Details Customer Details 0
To create a new customer account you need to enter the customer's name and
o Contact Details a unique reference.
Name™ | Mew Customer Account |
o Customer Defaults
e —
° Credit Details Please enter the customer's address.
o Bank Address Streetl
Street2
Town
o Bank Account County
Post Code
o Opening Balance Country Ireland IE w

Cancel Back MNext

Name”* The customer’s (students) name. This is used in reports and
documents you can print and send to your customer, for example,
invoices.

A/C Ref* A unique reference code for the customer. It can include letters or

numbers or both, for example SMITHO1, but you can't change this
once you save the record.

Your customers are listed in the Customers window and by default they
are sorted by this code.

As you begin typing text in the Name box, a reference code is
suggested for you. You can change this reference code if you want.

Address lines This is used in documents you can print and send to your customer
such as invoices, credit notes, letters, labels and statements.

* This information is mandatory.
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Contact Details

Telephone The number you expect to use most often when contacting this
customer.

Fax Record a fax or telex number.

Email 1 The email address you expect to use most often when emailing this
customer.
Tip: When the customer’s record is open, you can generate an email
based on this address.

Website The customer’s website address.

Tip: When the customer’s record is open you can access their website,
provided you are connected to the Internet.

Contact Name

The person responsible for the account, though you can use this box
to hold any other related information.

Account Status

Select the status that applies to this account. When creating an
account, the status Open is the default.

Customer Defaults

Nominal Code

This is the nominal account you expect to use most often to post the
net value of any sales transactions when dealing with the customer.

When you record an invoice, credit or sales order the nominal code
appears but you can change it if required. The code is also displayed
when you record a credit note for the customer.

The nominal code you want to use for net sales from the drop-down
list.

The code that appears is taken from your Customer Defaults.

Tax Code for
Sales

Use Default When creating an invoice or sales order and selecting a product, the
Nominal Code | nominal account suggested for your net sales posting comes from the
for Sales default on the product record.
If you prefer to categorise your sales by customer, for example, if you
have a set of nominal codes for sales to customers in different regions,
select this check box.
Use Default Select this check box if you want to use your default sales tax code.
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6.3 Setting the processing date

When you're processing in Sage 50 Accounts the date you use on every transaction is
of critical importance to the accuracy of your data. By default, Sage 50 Accounts uses the
date from Windows as its default date, that is, today’s date.

If you want to change the default processing date, you can do this in:

Settings » Change Program Date

Change Program Date | %= |

Enter a new date to be used as the default for fransactions.
This date can be changed at time of posting.

Default Program Date  [01/02/2015 o

| QK || Cancel |

Customer Default

The terms agreed with the customer must be entered before processing invoices. If customer
terms are not required please tick the box in Customer defauls for terms Agreed.

Settings » Customer Defaults

Customer Defaults | _§:§_ |

Record Statements | Ageing | Discount

Defaults
Country |Ire|and IE v |
Currency 3 Euro |

Std Tax Code T9 0.00 Def. N/C

Department™ Default

Discounts
Discount % Type lNo additional v |
Price List | v/
Account status
Default |0 Open w |
Terms Agreed
OK | | Cancel |
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6.4 Customer Invoices & Credit Notes

Processing Invoices not created in Sage

Batch invoices and credit notes

Schools may have created the School Fee invoices/credit notes using Excel or Word or other
software for billing. The school can enter these invoices/credit notes using the batch invoice
and credit functions. Using the batch method will allow the school to enter the fee invoice/
credit note against the relevant customer.

This can be accessed from Customers by clicking Batch invoice or Batch credit.

/77 =
S S N\ S BEE IT &
Mew Wizard Activity  Batch Batch ustomer

Disputes Price lists
\.invoice credit / receipt

AN Z

E Batch Customer Invoice

01/09/2016 0001 3300 0

Department™ |Details

l2016/2017

== ]
= 5= = = [ = B
Llie = B E ™ = I
Clear Insert Remove Copycel Copycellabove Calculate Memorise Recall | Printlist Send to
form | row (F7) row (F8) above (F&) +1(Shift +F6) net(F3) Excel
AfC Tax Rate 0.00
NfC Total 4000.00

4000.00 T9

0.00

Creating Invoices and Credits Notes in Sage

The invoices and credits module allows you to create and produce a printed document for
invoices and credit notes as well as updating the sales ledger.

Invoice automatic numbering

Before using the invoices and credits module it is important to set the starting number for
invoices and credit notes.

Settings » Invoice & Order Defaults » Options tab

Invoice and Order Defaults |_§E__
Discounts | Intrastat | Cash Sales Lick Print Emiail
General | Footer Defaults Update ledagers

Invoice and Order Numbering

Invoices start from

F

Credits start from

Sales orders start from

o al e

This enables the system to continue with the numbering sequence used in creating the
invoice

To ensure that you do not overwrite the automatically assigned numbers the system can lock
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the auto numbering under the General tab. To assign your own invoice/credit numbers do

not lock the numbering.

Creating an Invoice

B F - Y

MNew  Mew Recurring Update Quick print  Print  Email
invoice credit items  ledgers
Y[ At || | All records (0)

1. Invoicing and credits » New invoice.

2. From the relevant drop-down lists, choose the type and format of the invoice you require,
for example, to create a product invoice, from the Type drop-down list choose Invoice and
from the Format drop down list choose Product.

3. Use the top part of the window to enter the main details about your invoice or credit.

4. Enter the items, one line at a time. The product details automatically update into the
invoicing window from the product record.

a. Invoicing using Product Codes

Product Code* | Enter the product code for the invoice item. Choose the code from
the drop-down list or you can type directly into this box.
You can also select the special product codes from the product
code list. If you use the special product codes the Edit Item Line
window appears automatically.
If you need to add service items to your product invoices there are
special product codes available.

Description The description automatically updates with details from the
product record. You can change this if required.
If you want to enter any one-off product details, double-click the
Description box or press F3.

Quantity Enter the quantity of the product here. The default is one unit of
the product.
If you have already entered a quantity on the Edit Item Line
window, it appears here.

Price The unit price from the product record appears here. If a special
product code has been entered, the value entered in the Edit
[tem Line window appears here. You can change these values if
required.

Net The net value calculates automatically and cannot be edited.

VAT Vat Zero.

* This information is mandatory.
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b. Invoice using Service Invoice

Invoices and credit notes are free-text based. This means you manually enter a
description for the services or goods.

Details* If you are creating a service invoice, use this text box to enter
details of the service provided

Amount Enter the price of the service provided.
Net The net value calculates automatically and cannot be edited.
VAT

* This information is mandatory.
The item line details can be edited further by pressing F3.

~ - Tip:
—!~ The following additional fields are available for each item line:

Units Product invoices only

Enter the unit type here, for example, you may sell items by the
sheet or roll. This is for reference only.

Details Service invoices only

Enter details of the service in this box if required. The details of
the service entered on the main invoice window appear here by

default.
Comment 1 You can enter additional comments about the product item lines
and 2 here.
Unit Price The sales price from the product record appears here, unless a

customer price list is in use.

Discount % The total discount percentage appears here. This can be changed
but any changes made here do not save back to the Customer
Record. To view a breakdown of how this discount is made up, click
Discounts.

Disc. This shows the value of the discount the customer will receive. The
currency reflects the currency on the customer record, if you have
activated Foreign Trader.

Nominal* This is the sales nominal code taken from either the Product
Record or the Customer Record. This depends on the selection of
the Use Default Nominal code for Sales check box in the customer
record.

Tax Code The default tax code can be taken from a number of areas
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Department This is the default department for the product.
Line Enter any additional information about the item line in this box.
Information

5. Click OK.

6. To apply a net value discount, in the Deduction area at the bottom of the window, click
the drill-down button in the Description box then complete the Edit Item Line window as
follows:

a. Enter a description for the discount of up to twenty five characters.

b. If required, you can enter further comments of up to sixty characters.

c. Enter either a discount percentage or a discount value into the appropriate box. The
corresponding discount amount or percentage appears.

7. Check the totals.

There are a number of other options at the foot of the invoice that you can complete as

required.
I?"/ Service Invoice p— |ﬂ|
} remeres  — E— o L]
—] Q 7 X
LEE TN S22 B as |
IClear Insert Remove Copycell View item Payby Cash Memorise Recall Delete Quick Print Sendto
form | row (F7) row (F8) above (F&) {F3) card  sale print Excel
we e [moce || Sevielwoce |
Order . 5 - i 2
Fodts orma E’uce nv.No.
et Date* 01f09/2016 | Order No

acs (O] v]memio. | rtemioft

|Amount € |Net €

Fee study ~/ 250.00 250,00 0.00

To set the nominal code for the service invoice click the arrow in the details line.
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The Description line will update your ledgers, whereas the Details will print on the
invoice.

Ef Service Invoice

[
== E= B v — —1
faain| : X
I =5 39 M 342 @ ) =
Clear Insert FRemove Copycel Viewitem Pay by Memorizse  Recall Quick Print Send to
form | row (F7) row (F8) above (F&) (F3) card print Excel
Type ]
Order
Format i Inv
Footer Service
Payment Date® 02/06/2016 | ord

N

|Amount €
Fee Study o | 5000.00| 5000.00
Edit Item Line [ = |
Details
Description Fee Study
Details Fee Study -
Order Reference Order Line Reference | 0
Values
Qty/Hours Discount % NetEUR € 5000.00
Unit Price EUR € Disc. EUR € 0.00 T | VATEURE 0.00
Posting Details
rox ode
| P |
Invoice Amendments
Clear form Clears the information you have entered so far.
Quick print Print a copy of the invoice instantly. This does not update the

invoice details to the ledgers.

Print Prints the invoice. You can choose from a list of invoice layouts and
agree to update the values to the customer record and nominal
ledger if required.

Send to Excel Open the invoice details in Microsoft Excel.

Insert row (F7) | Inserts a blank line in the row above. You can use the function key
F7 as a shortcut.

Remove row Deletes the whole line of information. You can use the function key
(F8) F8 as a shortcut.
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Copy cell Copies information from the field above. You can use the function
above (F6) key F6 as a shortcut.

View item (F3) | Opens the Edit Item Line window, displaying the information
relating to that particular item on the invoice or order. You can use
the function key F3 as a shortcut.

Navigation When you select to edit more than one record, you can use the
arrows arrows to easily navigate between them.
Close Closes the window.

8. When you have finished entering the details, to save the invoice or credit > Save.

Duplicating Invoices

When creating invoices with the same details and value it will save time to use the duplicate
feature to copy existing invoices to create new ones.

Select the invoice you want to duplicate from the list and click Duplicate from the invoices
and credits toolbar. A new invoice will appear. It is important that you check all details
before saving. Credit notes can also be duplicated.

h‘/ Service Invoice - Duplicate of < 1 > Pr—— | = |E = |
= rer et — ]
1 Q X
b= 2 T K B8 § o K
Clear Insert Remove Copycell View item Payby Cash Memorise Recal Quick Print Send to
form | row (F7) row (F8) above (F&) (F3) card  sale print Excel
e e v][ S ]
Order
Format Service Inv.No. <AutoMumber >
Footer
S Date™ [10/05/2016 | Order o | |

acs [0 MemNo, | ltem 1of 1

|Amount €

Fee 2016/2017 " 3000.00| 3000.00 0.00

Deduction |Description Total EUR € 3000.00 0.00
Net Value Discount =] 0.00 | Carriage EUR € 0.00 0.00
Gross EUR € 3000.00

Less Deposit EUR € @ 0.00

Amount Due EUR € 3000.00

Save Close
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Printing Invoices

Invoices can be printed directly within the invoice screen prior to saving it or subsequently by
selecting the invoices from the invoices and credits module and clicking the Print button. If
no invoices are selected, you will be prompted to print all invoices.

B BF = B K

MNew  Mew Recurring Update
nvoice credit items  ledgers
Y[ Fiter || | All records (1)

|Mame

1 Srv 01/09/2016 IMB

When using the Print button an invoice layout has to be selected each time. The layout that
that suits your school should be added to favourites for future use. With the Quick Print
button this is not necessary although the first time you use quick print, you will be asked to
select a default layout that will automatically be used in the future:

| ayouts ‘ &l &
[ | ¢ Filters All -
DI it Beiete  Rre st Brintes Exog Bl SEGAI | —_— = — —
Fovurics
Layouts Add the documents that you use most often to Favourites to access and generate them quickly. Documents are added and

removed by clicking the staricon. You can drag and drop your favourites into any order you want.

MName Description Last Run Filename

Designed to be emailed or printed

on plain paper. Indudes discount
‘*,' A4 Inv Setflement Discount - Plain Paper (Print or Email)  amo tlement & é % ?g &
disce be sent via

post or email,

Emailing Invoices

If you wish to email invoices to customers, ensure the customer's email address is entered in
the Details tab of their record.

Email Settings & Addresses
Email 1 | =|
Email2 | = |
Email3 | = |
1 send letters, statements, etc, to this customer via email [
1 send invoices to this customer via Transaction Email ]

The first time you email an invoice, you will be prompted to select a default layout. It is
important to select an email layout to ensure the invoice is sent in full.

The list of Invoices will be updated to show that it was printed /emailed. Invoices can be
edited and changed before they are posted to the ledgers. They can also be re-printed
at any time.

Once the invoice is complete and sent to the customer the sales ledger should be updated.
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6.5 Updating Sales Ledger

Once the invoice is complete and has been sent or given to the customer, it should be
updated to the accounts.

From the Invoices and credits module select the invoice(s) to be posted and click Update
ledgers.

B BB FAER IR

Mew Mew Edit Duplicate Recurng Update edit Quick print  Print  Email
voice  credit items Iedgers,ﬂwmce

| Al records (1)

[Mame

The update routine generates a report which will display any problems with the update such
as a missing nominal code.

Otherwise it will confirm the posting details:

The Posted column on the invoice list indicates whether the invoices have been updated
or not. Any invoices that have not been updated will have to be amended. They can then be
taken through the update routine again.

The program will not allow an invoice to be posted twice. If a copy of an invoice that has been
updated is reprinted, notes or messages can be added, but values posted to the accounts
cannot be changed.

Credit Notes

Creating and posting credit notes to customer accounts is exactly the same as for invoices.
When raising the credit note ensure the invoice Type is set to Credit.

%EW?RWE T

New Edlt Duplicate Recurring Update Credit = Quick print Print
nyoice Uedit/ items  ledgers invoice

Y| Fiter || | All records

1 Srv 01/05/2016 IMB

There is also a Credit Invoice button, this allows you to highlight an existing invoice and
create a credit note with exactly the same details. When you save this credit note you will be
given the option to automatically update it and allocate to the invoice it was created from.

5 HE B B F %)

Mew  Mew Edit Duplicate Recurring Update Credit mekprlnt Print
nvoice  credit items  ledger \lrwolce,

EH Fiter || | All records

1 Srv 01/09/2015 IMB
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=, Sani i i =B =
LE/ Service Credit from Inveice < 1 > Pr— =iy) _|
== — c— = —
=2 X
&g =2 5 M o |
Insert Remove Copycell View item Memarise Quick Print Send to
row (F7) row (F8) above (F&) {F3) print Excel
S ——
= oe (oeat D[ SeveeGedt |
Order ~— ,//
Format Service Crd.No. <AutoMumber >
Footer
Date®  [02/06/2016 | OrderNo | |
Ajcx (@ Item Na. Ttem 1of 1

|Amount €

|Net €

5000.00 | 5000.00| 0.00

Deduction |pescription Total EUR € 5000.00 0.00
Net Value Discount =] 0.00 | Carriage EUR € 0.00 0.00
Gross ELUR € 5000.00

Amount Due EUR € 5000.00

Save Close

To Delete an Invoice or Credit Note

1. Invoices and credits » choose the invoices or credit notes you want to delete » Delete.

2. To delete the invoice or credit note » Yes.

If any of the invoices or credit notes selected haven't been printed or posted the software

displays a warning message and you're prompted to confirm deletion once more.
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6.6 Customer Receipts

Customer receipts can be recorded in the customer ledger by selecting Customer Receipt
from the Bank Accounts module or the Customers Module.

D @ N\ S EBEE & 4

ew Wizard Activity Batch Batch Customer Aged
invoice credit  receipt  debt

Y| Aiter || | All records (1)

4 |Name |Inactive

JMEB B

Or Bank Account

T SR & & &8 B =
Mewjedit Activity Bank Reconcle Bank Payments Customer Bank Supplier R
- feeds transfer - receipt receipt refund
1300 Current Accour
1310 Deposit Account]

The upper part of the screen is used to select the:
a) bank receiving the payment,

b) the customer account number,

c) the payment date,

d) amount being paid and

e) the payment reference for the transaction.

The reference and date are very important, especially if there are several payments that
need banking on the same day. We recommend using the same date and reference for all the
individual payments listed in the same paying-in slip. This allows the bank reconciliation to
group the transactions as one paying-in entry.

To activate grouping, select Settings » Bank Defaults and tick the Group Items in Bank
Rec box
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ﬁ Customer Receipt - Cumrent Account E=REE 25

i na| Ll

B o X
Il 89 N 5 W F
Clear | Payby Payin Wizard Automatic —Department | Printlist Send to
form card  full (F3) Excel

Bank Details Customer Details Receipt Details

Account Ref Account® JME ¥ Date* 30/09/2016  ©

e | current Account o [me ||| Amount 3000.00 =
Balance 500.00 Balance | 3000.00 | Reference | 1456

Show |AII V| From | ik :| To | i :::| [Cist Invoice Credit by item line
No. |Type f |Tic | Amount €|Disputed? |
5 M8 o1j0g/2016 1 _ nfa Fes2016/2..nfa |  3000.00 _ 0.00|
Analysis Total 0.00
Save || Close |
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6.7 Customer Statements

Sending your customers statements on a regular basis is a good way of keeping them
informed, and it can also gently remind them that their payments are due or overdue.

To generate customer statements

1. Customers » select the required customers » Statements.

2. Layouts » select the statement layout you want to use.

3. From the report browser toolbar, click the action you want to take, for example, Print or

Preview.

4. If a Criteria window appears, enter any required criteria » OK.

Tip:

If you want to exclude any future sales receipts and sales payments on
account from your statement, select the Excl. Later Payments check box.
This gives you the flexibility to run retrospective statements - that is to
include or exclude invoices, depending on the payment date.

View available statement options

A4 A4 statement layouts are designed for use with laser printers.
Individual or If you select a statement including the Individual option, each
Grouped transaction appears on a separate line in your statement.

If you select a statement including the Grouped option, transactions
which were entered as a group, appear as a group transaction on a
single line.

2 Part or Tear

Two Part statement layouts print your statement on the top sheet and

Off your remittance on the carbon sheet below.
Tear off statement layouts print your statement and remittance side by
side on a sheet.

O/S Only or To show only outstanding transactions on your statements, choose a
statement layout including the O/S Only option.

Al To show all transactions on your statements, choose a layout including

the All option.
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6.8 Customer Activity

This is a great way to view the history of trading between you and your customer. It also
shows the customer's credit limit and balance as well as the total amount they have paid and
the turnover for the year.

A summary of dealings you have had with the customer appear in a list. Each line in the list
represents a transaction such as an invoice or payment.

To view the activity:

Customers » double-click the required record » Activity.

To filter the transactions which appear:

Show drop-down list 2» choose the criteria you require.

If you choose Custom Range, a further window appears where you can define a transaction
number range, date range and transaction type. The selections you make here are shown in
the boxes alongside the Show drop-down list.

To view or hide the breakdown of the selected transaction:
Click the Show Detail / Hide Detail button.

Show Detail opens a window breaking down any selected transaction into its component
parts. For example, a sales receipt is broken down into the invoices it paid off, where as a
sales invoice lists any receipts allocated against it. Hide Details closes the window showing
the detailed breakdown.

The Activity window
A/C This shows the customer account reference.
Name This shows the name of the customer.
Credit Limit This shows the credit limit entered in the Credit Control tab.
Balance The current balance of the customer account.
Amount Paid Total receipts from this customer.
Turnover YTD The year to date turnover value for this customer. This value is net of

VAT. The YTD figure is taken from the Sales tab and clears when you
run the year end routine. The value can be manually amended in the

Sales tab.

No The number of the transaction.

Type The following transaction types may appear:
S| = Sales Invoice

SR = Sales Receipt

SC = Sales Credit

SA = Sales Payment on Account
SD = Sales Discount

SP = Sales Payment
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Date The date of the transaction.

Ref The transaction reference.

Details Any details entered for the transaction.

Amount The value of the transaction.

0/S The amount of the transaction that is still outstanding.
Debit If the transaction represents a debit, it is shown here.
Credit If the transaction represents a credit, it is shown here.
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6.9 Unallocate a Receipt

Section 6: Customer Module

If you have posted a receipt or credit against an invoice in error, you can use the “Unallocate”
option to unlink the transactions. A sales receipt (SR) becomes a payment on account (SA)
when it is unallocated, and it can then be allocated against a different invoice.

E Customer Record - km

- = &= |

L BB &

E B ®v @& &

Clear | New New | Delete | View Unallocate Hide Printlist Send to
form | invoice order item detail Excel l
Details alc Balance 2500.00
Defaults e
Name | km Amount Paid 2500.00
Credit Control
Bank Credit Limit 0.00 Turnowver YTD 5000.00
Communications
Memo Show: | All Transactions v Date: |01f01f1330 to 31/12/2089 | Type: |N\ ofsonly [ Trans.:| 110366
No « [Type  [Date |Ref |Details Amount Debit|
Sales 365 5L @ 02/06/2016 1 Fees 5000.00 2500.00 p 5000.00
366 SR 01032016 Sales Receipt 2500.00 2500.00
Orders
Graphs

No|Type |Date

|Ref nfc |

Dept|[ExRef  |Details

|[TexC|  Amount|  Debit|  Credit| Trans. Balance

=] 36658 01/03/2016 1300 0 Sales Receipt ™ 2500.00 2500.00
02/06/2016 1 0 2500.00 to SI 365
Future Current 30 Days 60 Days 90 Days Older
0.00| [ 250000 | .00 | 0.00| | 0.00| | 0.00

Record 10f1
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6.10 Credit Control

Section 6: Customer Module

Credit control is essential and it is very important that the school knows who owes money.

The credit terms for each customer must be set in the Customer Record » Credit Control.

' Customer Record - JMB

£
- . [ )
I BB &
Clear New MNew | Delete
form | invoice order
Details Terms
Defaults
Credit Contral
Communications Sett. Discount III
Average Time to Pay I:I Days
Activi
Sales ;
Graphs Bureau w
Priority Customer D
Account status |0 Open v |
DUNS Mumber
Restrictions
[Jcan charge credit [ |Restrict mailing
[Iterms agreed

The aged debt report will list all customers together with details of their outstanding debt. This is

printed from the customer module.

o % N\ e

Mew Edit Wizard Duplicate Batch

changes

e < f’g\n -

Activity Batch Ba

Customer ed Disputes
invoice credit\_receipt /debt
\t”

Y[ Aier ||

| All records (1)

AfC A |Mame

The aged balance window appears showing the grand total of any outstanding invoices by ageing

period for each customer. To see the actual invoice details for these debts, highlight a customer and

press the Detailed button.
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6.11 Customer Monthly Reports

As part of the month end procedures the following reports should
be printed and filed on a Customer Report file.

Day Books: Customer Invoices
Day Book: Customer Credit Notes
Day Book: Paid Invoices

Customer Activity Summary
Customer Activity Detailed

Sales Ledger Department Analysis
Aged Debtors Analysis Summary
Aged Debtors Analysis Detailed
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7.1 Lock Period Date

Once you have produced your monthly reports in Sage 50 Accounts, you can prevent
transactions from being posted before a set date, which means that no more transactions

can be posted back into earlier months

To enable this feature , select Settings » Lock Date

Lock Date Settings = o

If you wish to prevent postings before a spedific date,
enter that date below.

[ JLodk posting before: I

Mote: All dates prior to this will now be locked and only
users with Access Rights to "Lock Dates” will be able to

post,

(84 Cancel

The user can choose to override the blocking of transactions during transaction entry.
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7.2 Financial Reports

To help you make financial decisions it's essential for you to understand how the school is
performing. For an easy way to see this, there are several useful reports available in Nominal
codes including:

* Audit Trail Report

* Trial balance report

* Nominal Activity Report

+ Balance sheet report

* Income and Expenditure report

+ Budget report

You can start reporting on your transactions as soon as you enter them into your software.

The Recommended reports can be stored as favourites in Sage.

To generate a financial report
1. Nominal codes » Reports.

~ - Tip:
’Q~ You can also access some of these reports from the Nominal codes
toolbar, for example, Profit & loss.

Select the required report area, for example, Nominal budgets.
Select the report you want to run, for example, Budget Report.

Report browser toolbar » click the action you want to take, for example, Print or Preview.

o~ W N

If a Criteria window appears, enter any required criteria » OK.

\II

~ - Tip:
-Q~ To make this even easier, you can add reports to Favourites.

-
Nominal code reports = |
(= J@ U3¢ § % % § % Fifters, Al .
Favourites Favourites
Balance sheet Add the documents that you use most often to Favourites to access and generate them quickly. Documents
are added and removed by clicking the staricon. You can drag and drop your favourites into any order you
Day books want.

My nominal code reports
Nominal activity
Nominal budgets

Name Description Last Run Filename S

Can only be run for

Nominal details ¥ Balance Sheet ec s 27/05/2016 16:45
Profit and loss detall tab of the
Trial balance nominal record.

m

Lists all nominal
codes, and every

. Nominal Activity - Exduding No transaction, but 5

W Trancactons erdlirios those rodes 02032016 1133 NOMACTX
with no transaction
activity,

Displays the debit or
credit balance for

7" Nominal Balances each nominal code, 08/12/2015 13:30 NOMBAL
induding codes with
no balance.

All journal

" Day Books: Nominal Ledger e

08/12/2015 13:28 NOMDAY

Actuals, budgets and

prior year values for
Nimeminal Darnrd Valise 2k menth inch idine MAMALS
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Audit Trail Report

Section 7: Reports

The audit trail is a list of transactions entered into Sage 50 Accounts. The Software
automatically allocates a sequential number and type to each transaction. To run the Audit
Trail report select Transactions and click Audit trail report from the toolbar.

Customers E E], @&— E
Quotations Audit tral  Accounts  Verification | Edit Unallocate Delete | Sendto Reports
s report audit reports Excel
ales orders
Invoices and credits EH Filter | | Find | | 2443 | Q O All record
No 4 |Type |Nominal  |Dept |Details
Suppliers 3376P 1800 5010 @ 2015-2064
Purchase orders 338EP 1800 5010 0 2015-2065
333BR 1800 1950 0 2015-2016
Products and services 340BR 1300 2320 a 2015-2017
341BR 1800 2240 0 2015-2018
- 342BR 1800 P00 2015-2019
) 343BR 1800 3020 0 2015-2020
Mominal codes
e 344BR 1800 050 O 2015-2023
34582 1800 3100 0 2015-2024
346 BR 1300 3130 0 2015-2025
347BR 1800 3240 0 2015-2026
e st 348ER 1800 3250 0 2015-2027
Departments 43R 1800 3275 0 2015-2028
IS0BR 1800 320 0 2015-2029
There are four types of Audit Trail
Audit Trail Report | = |
Audit Trail Type Output
{®)Brief {JPrinter
GSummar}' DPFE'U'iEW
(JDetailed (®)File
{)Deleted Transactions { JEmail
[[]Landscape Output Run Cancel

< BACK TO CONTENTS »



FSSU SAGE Accounts Manual

Section 7: Reports

The summary audit trail shows full details of each transaction.

® " Audit Trail (Brief} - Preview

hPrint LAEmeil REport I PageSetup Printer Offsels [4Edit Stles Close GotoPage
'|"‘I\"'1"'I"'2"'I"‘]"'I"'4"'I"'5"‘\“'G"'I"'?' | |sw|
B E
; Date: 02/06/2016 FSSU SAGE 50 Page: 1
= Time: 16:53:44 Audit Trail (Brief)
= Date From: 01/01/1980 Customer From:
Date To: 31/12/2019 Custi To: 2227277
2 Transaction From: i Supplier From:
E Transaction To: 99,999,99 Supplier To: ZZZ777TT
= Exclude Deleted Tran: pg
i No ItemsType A/C Date Ref Details Net Tax Gross
1§ 1 1D 1420 31/08/2014 O/Bal ofbal 541,820.00 0.00 541,820.00
E ) 1. ¢ 1430 31/08/2014 O/Bal ofbal 539,369.00 0.00 539,369.00
m a3 1 I 1460 31/08/2014 O/Bal ofbal 135,509.00 0.00  135,509.00
= 4 1 1C 1470 31/08/2014 0O/Bal ofbal 123,774.00 0.00  123,774.00
5 1 D 1720 31/08/2014 O/Bal ofbal 589.00 0.00 589.00
- 6 1 1D 1800 31/08/2014 O/Bal o/bal 27,026.00 0.00 27,026.00
7 1 1D 1810 31/08/2014 O/Bal ofbal 153,805.00 0.00 153,805.00
3 8 1 JC 1900 31/08/2014 O/Bal of/bal 42.00 0.00 42.00
- 9 1 I 5 2100 31/08/2014 O/Bal ofbal 10,618.00 0.00 10,618.00 &
% 10 1 JC 2105 31/08/2014 O/Bal ofbal 32,974.00 0.00 32,974.00 =
. 1 Jc 2230 31/08/2014 O/Bal ofbal 903,00 0.00 903.00 =
= 12 1 1 2250 31/08/2014 O/Bal ofbal 2,449.00 0.00 2,449.00 v
13 1. G 2440 31/08/2014 0O/Bal ofbal 3,789.00 0.00 3,789.00 -4
| [page1of7 | 100 ©-U——@ E|

It is recommended that you use the transaction number range rather than the date
range as this avoids the omission of transactions.
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7.3 Board of Management Reports

A full set of reports should be generated at least 3 days before the scheduled board meeting.

The following Reports must be printed every month and filed on the monthly Management
Report file.

1.

2.

Balances on All School Bank Accounts

Bank Reconciliation Statement for each Bank Account including cheques
and Lodgements listings

Income and Expenditure Account showing actual versus budgeted figures
Balance Sheet

List of all creditors / List of accruals / Summary of income received for
next school year and prepayments

Capital Income and Expenditure Account (Prepare manually)
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7.3.1 Bank Account Balances

A list of all the schools bank accounts together with their balances and last reconciled date
can be printed from Sage 50 accounts.

13 I W oaules etongs 1000 Tavouries Eay =)
. Y S i i —
Customers €. o X
DoReL & B B @@E EE R & B @ H
Quotations Mew/edit Actvity Bank Recondle Bank Payments Customer Bank Supplier Recurring Cash Deposit Cashflow Download | Delete Clear | Printlist Send|
- feeds transfer - receipt  receipt  refund items  register cash receipts Exx]
Sales orders.
Invoices and credits afc A |Name
1800 Current Account 97957.16 30/05/2016
Suppliers 1810 Deposit Account 153805,00
1900 Petty Cash Account 42,00

Purchase orders

Products and services

Mominal codes

VAT

Transactions

Columns can be selected to include bank reconciliation details.
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7.3.2 Bank Reconciliation Statement

Section 7: Reports

The bank accounts must be reconciled each month and the Bank Reconciliation report
printed for each account. Copies of the Bank Reconciliation reports must be included as part

of the reports for the Board.

Date: 02/06/2016 FSSU SAGE 50 Page: 1
Jromi o R Bank Reconciliation
Bank Ref: 1800 Date To: 02/06/2016
Bank Name: Current Account Statement Ref: 1800 2016-06-02 01
Currency: Euro
Balance as per cash book at 02/06/2016: 100.457.16
Add: Unpresented Payments
Tran No Date Ref Details €
329 28/02/2016  February  2015-2055 5,144.50
333 28/02/2016  February  2015-2060 7,154.63
335 28/02/2016 February  2015-2062 9,653.26
337 28/02/2016  February = 2015-2064 15,792.50
338 28/02/2016  February  2015-2065 19,737.31
57,482.20
Less: Outstanding Receipts
Tran No Date Ref Details €
339 28/02/2016  February 2015-2016 0.54
353 28/02/2016  February  2015-2033 25.00
359 28/02/2016  February  2015-2040 32.00
(57.54)
Reconciled balance : 157,881.82
Balance as per statement : 157 881.82
Difference : 0.00
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7.3.3 Income and Expenditure Account

Section 7: Reports

The income and expenditure account summaries the schools activity for the period specified

in the report.

The recommended reports for the Board of Management are run from the FSSU templates

stored on the computer desktop.

1. Go the the computer desktop and open the FSSU reports file.

2. Click on the Income and Expenditure report

3. Refresh connections

Excel Report Design - Connections ‘ |

Steps

1) Reset workbook [# Done

j ¥ Done

I Indude Archives

Reset workbook for this computer

2 Select Sage version I Sage Line 50 v22

3 Demodata or Archives I Indude Demodata

£l Update company list

Get Company List ¥ pone

5 Select comparty name | 3 -F55U Master

(3] Enter Sage user name I manager

7 Enter Sage user password Pre—"

¥ Save Password

Company Datapath | C:\PROGRAMDATA\SAGEACCOUNTS |20 16\COMPANY. 001 \Accdata

Report Name | Profit & Loss Statement

[~ show Progress Report Reference 6.1
8) Refresh connections Hetreriy e
4. Enter the period for the report
5. Click update
6. The reportis generated
7. Print the report
02/06/2016 17:00
Mth 1 - Sep 2015
Nth 7 - Mar 2016
FssU Connections Update |
[E3]
il nominal [urrenv. Budget Difference 1 Year Pas

001 - Department Income 3010 - Capitation

3020 - DEIS Grant

3050 - Support Services Grant
3100 - Secretarial Grant

3130 - Caretaker Grant

3150 - Book Grant

3170 - Special Subject Grant
3150 - Home Economics Grant
3200 - Transition Year Grant
3210 - Leaving Cert Applied Grant
3220 - Grant for Traveller Sts.

o200 LT

42,088 :

22088 43,854

14,009
34866  21,06(
10,452 3,12
8,39 2,60
- 20
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7.3.4 Balance Sheet Report

The balance sheet report is a snapshot of the school’s financial position at a single point in
time.

The recommended reports for the Board of Management are run from the FSSU templates
stored on the computer desktop.

1. Go the the computer desktop on open the FSSU reports file.
2. Click on the Balance Sheet report

3. Refresh Connections

4. Enter the period for the report

5. Click update

6. The report is generated

7. Print the report

02/08/2016 17:01

01/09/2015|
29/02/2016]
01/09/2014

Update | Connections

Values
Nominal Code B3 Current Period 1 1 Year Past
1420 - Capital: Furniture, Fitt 541,820 541,820

entOriet ategory
- Fixed Assets =105 - Fixed Assets

1430 - Capital- Dept- Fixed Fittings & Eq (539.369) (539,369
1460 - Capital: Computer Equip 135,508 135,509
1470 - apital: Depr- Computer Equipment (123,774)

05 - Fixed Assets Total 14,186
=/Net Current Assets =106 - Current Assets 1720 - Prepayments 589 589
1800 - Current Account 100,457 66,571

1810 Dpasit Account

2440 - Accruals
9997 - Vat on Purchases (Do Not Use)

=07 - Current Liabilities

(6.231)
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7.3.5 Trial Balance

The trial balance is a list of all nominal records that have a balance at the period date
requested. It is a checking report and its main purpose is to make sure that the sum of all
debit balances equals the sum of all credit balances.

B " Period Trial Balance - Preview

=4 Print =1 Email =] Ex_pod in| Pa_ge Setup lé?rinterf)ﬁsets Edil Slyl.s Clese Goto Page .17
|...|"‘.1.......2......‘3‘.......,.......5..‘_..6.......,......\8‘.]
1] Date: 02/06/2016 FSSU SAGE 50 Page: 1
i Time: 17:03:00 Period Trial Balance i
% To Period: Month 12, August 2016
i N/C Name Debit Credit
= 1420 Capital: Furniture, Fitt 541,820.00
: 1430 Capital: Dept: Fixed Fittings & Eq 539,369.00
= 1460 Capital: Computer Equip 135,509.00
% 1470 apital: Depr: Computer Equipment 123,774.00
3 1700 Sales Ledger Control 2,500.00
- 1720 Prepayments 589.00
. 1800 Current Account 97,957.16
= 1810 Deposit Account 153,805.00
- 1830 Deposit Account 9,000.00
¥ 1900 Petty Cash Account 42.00
= 1950 Cash Control Account 0.54
- 2100 Purchase Ledger Control 18,962.81 d
iii 2105 School Income Received in Advance 32,974.00
= 2200 Net Wages Control 2,121.09 |
= 2230 PRD Control Acount 903.00 -
© 2250 PAYE/PRSI Control 2,695.50 =3
3 2260 VAT Control Account 810.00
| lpageroiz 10w OG—@®

If the totals on your trial balance do not balance this may indicate that your data is
currupted.

To investigate, run the Check Data rotine from File > Maintenance »» Check Data

Each value is drillable. Click on the value of the account and it will drill to that accounts
nominal activity to display where the figure has been drawn from.
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7.3.6 Nominal Activity Report

Section 7: Reports

This report lists all the nominal codes showing the current balance and the transactions for
dates selected.

Nominal Codes » Reports. Nominal Activity

Criteria for Nominal Activity

| Criteria Values

Enter the values to use

for the criteria in this report

Nominal Code Between {inclusive) ~ ~ and 59999999 -
Transaction Date Between (nclusive) ~ | 01/01/1380 ~ and 02/06/2016 -
Transaction No [Between nclusive) |1 [2] and [e9999999 =
Inc BfFwd Tran

Preview a sample report for a specified number of records or transactions (O forall) |0 |§H

Do not select Inc B/Fwd Tran

< BACK TO CONTENTS »

i@ Preview [=]& B4
= Print =1 Email | Printer Offsets | [EAEdit Styles | Close GotoPage 3 [£]
.1‘..|...1..|...3...|...4...|...;...|......|...7...|..|s..|'

B Date: 02/06/2016 FSSU SAGE 50 Page: 23

= Time: 17:05:04 . .

- Nominal Activity

J NfC: 5400 Name:  Security Account Balance: 1,387.17 DR

- Mo  Type Date Account  Ref Details Dept T/C Value Debit Credit V B

i 220 )0 31/01/2015 5400 sept-jan  sept-jan 2015 0 T9 1,772.00 1,772.00 = -

= 272 I 31/08/2015 5400 Ledger Ledger Year End o ™ 1,772.00 1,772.00 - -

m~ 321 BP 28/02/2016 1800 February 2015-2045 0 T4 1,387.17 1,382.17 N N

I Totals: 3,159.17 1,772.00

= History Balance: 1,387.17

: N/C: 5450 Name: Insurance Acoount Balance: 0.00

= No  Type Date Account Ref Details Dept T/C Value Debit Credit V B

] 78 D 31/0B/2014 5450 OyBal ofbal o 719 7,492.00 7,492.00 S E
- 164 JC 31/08/2014 5450 Ledger Ledger Year End 0 TO 7,492.00 7,492.00 - -

- 221 ID 31/D1/2015 5450 sept-en  sept-jan 2015 o T 3,545.00 3,545.00 K

i 273 JC 31/0B/2015 5450 Ledger Ledger Year End o T 3,545.00 3545.00 - -

= Totals: 11,037.00  11,037.00

f History Balance:

: MNfC: 5510 Name: Heating Acoount Balance: 6,717.74DR o
] No  Type Date Account Ref Details Dept T/C Value Debit Credit V B -
= 79 D 31/08/2014 5510 OyBal o/bal o 719 8,357.00 8,357.00 =& 5
= 165 JC 31/08/2014 5510 Ledger Ledger Year End 0 TO 8,357.00 8357.00 - - o
’ 222 ID 31/D1/2015 5510 sept-en  sept-jan 2015 0 T 2,060.0 2,060.00 S5 3 e

4 0.
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7.3.7 List of Creditors

Schools using the Supplier Module should print an aged creditors report

Click suppliers » reports » Aged Creditors Analysis (summary)

Supplier repol == &t

Favourites Aged creditors
Aged creditors Use these reports to show which suppliers you owe money to and how old your credit is. The ageing periods
are stored in the Ageing tab, accessed from Settings and then Supplier Defaults.
Credit control
Daily transactions
Name Description Last Run Filename =
Day books
Departmental
EC purchases

My supplier reports
Supplier activity
Supplier contacts

One line for each
Supplier details supplier, to quickly

view the outstanding
Supplier invoices Aged Creditors Analysis (Contacts) -By  balances. Lists each

4 * Balance {Descending) suppliers contact

Supplier statements name and telephane
number, Sorted by
the current balance.

PL_AGECE

Top suppliers

One line for each
supplier, to quicdy
view the outstanding
balances. Lists each
suppliers contact
name and telephone
number and the total
number of disputed
items. Sorted by the
current balance.

Aged Creditors Analysis (Contacts) - By
Balance {Descending) with Disputed
Items

PL_AGCED

Open the report and enter the relevant dates. Run the report

O T O T O D R, e e |

P Preview ERRE R

Date: 02/06/2016 FSSU SAGE 50 Page: 1
Time: 17:07:36 Aged Creditors Analysis (Contacts)

Report Date: 02/06/2016 Supplier From:
Include future transactions: Mo Supplier To:
Exclude Later Payments: MNo

*#% NOTE: All report values are shown in Base Currency, unless otherwise indicated **

Ajc Name & Contact Credit Limit Turnover Balance Future Current Period 1 Period 2 Period 3 Oldar
ADYD0L Advanced Learming € 0.00 0.00 -5,000.00 0.00 .00 0.00 -5,000.00 0.0o .00

Totals: ~5.000.00

l
.
El

5,000.00

E.
El

=
=
=

s L L A e e g e g e e e e e
3

Hd4p M
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List of Accruals

Schools using the Bank Module only must list all invoices outstanding.

Prepayments

A list of monies paid in advance must be listed e.g. Insurance

Income received in advance
Many schools request advance payments from incoming first year and other students.

Detailed records must maintained and a summary of the advanced income prepared for the
Board.
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7.4 Budget Report

A budget report shows your nominal budget values against the actual values, and the
difference, or variance, between the two. The report can be run for each department
separately.

Values are grouped into Income, direct expenses and overhead account codes based on your
chart of accounts, for both the month you specify, and the year-to-date. This means you can
quickly see which areas are doing well against school budgets and which areas aren't.

To run the Budget Report

1. Nominal codes » Variances.

Note: The Variances button only appears on the Nominal codes window
m toolbar if you've set the Budgeting Method to Standard within Settings »
Company Preferences » Budgeting tab.

2. Select the required output as follows:

Printer Sends the report to your printer.

Preview Use this to view the report on-screen.

File Saves the report to file, for example, to print at a later date.
Email Sends the report by email.

3. To generate the report, click Run » enter any required criteria » OK.
4. If there are any errors in your chart of accounts a warning message appears > to

continue and produce the report » OK.

Ea Note: If your software detects errors in your chart of accounts, your
j financial reports may be inaccurate. You should check your chart of
accounts and correct any errors as soon as possible.
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Section 7: Reports

/8 | Comparative Profit and Loss Report - Preview |=|E] %
i i | A Edil 1 B
T T T T T T T T T
4

= Date: 02/06/2016 FSSU SAGE 50
- Time: 17:08:50 .
s Comparative Profit and Loss Report
I From:  Month 1, September 2015 7
x To: Month 12, August 2016
i Chart of Accounts: FS5U
~
= Period Yei
= actm| uget Warancedh  priorvesr  prorves Yoot actusl burges tusget
~ m Yanance Yanance
- Income
L) Depart-nent Income: 11491653 00 11491653 10000 MBS0 £4,071.53 an 114,916 51 ang 11481657
2 Semel Gererstet incoma P 00 28100 100 aco Zamm0 wmw s aco v
il Other Income a0 000 00 100,00 3000 (30.00) (200000 0m a0 0.0
=2 =EE= m EEE i AR s Tz EEE= I EEE
= Exposditure
- Fuction Salaries 24189 000 7A14.95) 100,00 ace [2414.9) 1 2,8:9.9 ago (2,419.96) Iy
- Edhurstion Other 209703 0.00 21y 10000 1030 {8,166.40) [8.65) 2,272 13 ana 2977713}
P Rezars Munterance B Establshment A458536 0.0 [48,585.35) 10000 19,4800 (29,09 .35) (11831) A58 ano [40,585.35)
: Adminisiration 39,132486 .00 (3% 132.66) 100,00 150018 (26,111.55) (20053) 39,132.65 g 139,132.45)
I Fnancal 45215 0.00 (452.35) 10000 5500 (3028) (T2 45235 o {45235)
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7.5 Report Checklist

Reporting

Favourite Report. Use favourite reports to quickly find reports that you use regularly. Right-
click the report and choose Add to Favourites.

When running reports the dates can be entered or you can select the preset range by
clicking the icon beside transaction date

Bank reports 1. Bank Payments
Bank Receipts

Unreconciled Bank Transactions

M WD

Bank reconciliation report — print within Bank
Reconciliation section

—_

Audit Trail Report

Trial balance report

Nominal
Reports
Nominal Activity Report
Balance sheet report

Income and Expenditure report

o o~ W N

Budget report

—_

Creditors
Reports 2. Daybooks: Supplier Credit detailed

Daybooks: Supplier Payments- print from the Bank
Module

Creditor Activity Summary
Creditor Activity Detailed
Aged Creditors detailed
Aged Creditors Summary

Daybooks: Supplier invoices detailed

w

N o o s

—_

Day Books: Customer Invoices
Day Book: Customer Credit Notes

Day Book: Paid Invoices

Customer
Reports

Customer Activity Summary
Customer Activity Detailed

Sales Ledger Department Analysis
Aged Debtors Analysis Summary

W N o ok~ W N

Aged Debtors Analysis Detailed
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Board of 1. Balances on All School Bank Accounts

Management 2. Bank Reconciliation Statement for each Bank Account

including cheques and Lodgements listings

3. Income and Expenditure Account showing actual
versus budgeted figures

Balance Sheet

List of all creditors / List of accruals / Summary of
income received for next school year and prepayments

6. Capital Income and Expenditure Account (Prepare

manually)
Year End 1. Trial Balance
Reports Nominal Activity

Audit trail

Income and Expenditure
Balance Sheet

Bank reconciliation report

Unreconciled receipts and payments

© N oo s N

Aged Suppliers list-detailed (only for schools using the
Supplier module)

9. Aged Customer list-detailed (only for schools using the
Customer module)
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8.1 Introduction

Sage B0 Accounts works on a 12 month accounting period, referred to as the financial year.
You entered this in the Active Setup wizard when you set up your school.

It's really important to make sure this date is correct as when you record transactions their
values update to an accounting period on your nominal accounts based on your financial year
date and the transaction date. Sage 50 displays a warning message when a transaction date
does not fall within the current financial year. At that point you can choose whether to post
the transaction to your accounts or not.

At the end of the 12 month period you run the year end to change this date for the new
financial year

The year end process moves the total value on each Income and Expenditure nominal code
into the retained earnings nominal code, on the last day of the financial year. You can also set
up the budgets for the next financial year, and take an archive copy of the data as it is before
you run the year end.
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8.2 Preparation for year end

Before running your year end, ideally you should post all day-to-day transactions for the
year. This ensures that your management reports and year end postings are as accurate as

possible.

* All payments and receipts

* Reconcile all Bank Accounts

 All purchase invoices, credit notes and payments
+ Correct all errors

« All year end adjustments should be posted (Income received in advance etc.)

Print out Financial Reports

Run the check data — make sure to correct any reported errors before processing the
Year End option.

Check the chart of accounts — this program will check the chart of accounts to
establish which nominal codes are income and expenditure codes. This will ensure no
nominal codes are missed.

Change the program date — change the program date to be the last day of the
financial year.

Take TWO backups labelled ‘Before Year End’ — it is essential to back up the data
before running the year end, as this is the only way to go back to a pre-year position. It
is advisable to take two backups as a precaution against loss or damage of the backup
media.

Archive Data — select the option to archive data. This will enable you to view old data
without having to restore old backups.
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Section 8: Year End Procedures

8.3 Running the Financial Year End

To run the year end select Tools » Period End > Year End.

This will display the year end window as shown below:

Year End

Year End for 1st September 2015 to 31st August 2016

The Year End will cear all Profit/Loss Mominal Codes to Retained Earnings and optionally create
next year's budgets. You can post transactions to any time period without running a Year End.

Prepare for Year End
Detect and correct any data problems.

Check Chart of Accounts for any omissions.

Take a backup now to make sure your data is safe.

can be viewed as read-only data later,

Year End Options

budget values.

transferring profit and loss balances to retained earnings,

{usually the first day of the new finandal year).

Run Year End

Running Year End for 31/08/2016 wil:
- Change your finandal year to 01/09/2016 - 31/08/2017.

- Archive your data.

Archive your data in case you need to refer to itin the future. Archives

Base next year's nominal or stock budgets on current year actual or

The date to appear on the year end journal (Jast day of the current year)

Prevent new transactions from being entered before this date

- Transfer balances from al profit and loss accounts to retained
- Set the profit and loss nominal accounts for the new financial year to

Budget Options

< r—

|

| Run Year End | | Cancel | |

Help |

Check the details shown at the bottom of the Year End window are correct before

selecting the Run Year End option.

Confirm

Do you want to continue?

You are about to run your Year End for 01/09/2015 to 31/08/2016.

Yes ‘ |

Click YES if the year end dates are correct.
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A year end progress screen will appear. Once complete you will be asked if you would like to
print the Year End Journal Report. It is important to print the year end journal report.

Year End Report =]
Output
@Printer
Preview
= 8File

A final message appears that the financial year end has been completed, click OK.
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8.4 Check After Running the Year End

Run a Brought Forward trial balance. Select Modules »> Nominal codes > Trial Balance

Criteria for Period Trial Balance L= ]

Criteria Values

Enter the values to use for the criteria in this report

Pecnd e
Preview a sample report for a specified number of records or transactions (O forall) |0 EI
(i) e

* Make sure there are no income and expenditure codes on this report

Next, Check your data again. File > Maintenance > check Data

Finally take another backup of the data and label it ‘After Year End’

* Do NOT clear the audit trail.

 Year End Report - Preview =@ =
T R T S T IO - T R A O R o O IO O~ O IO 1~ A S IO SO e O S RNV

= Date: 02/06/2016 FSSU 03/03/2016 Page: 1

B Time: 17:20:33 Year End Report

I No Items Type A/C Date Ref Details Net Tax Gross

i 32 1 D 3010 31/08/2016 Ledger  Ledger Year End 42,088.00 0.00  42,088.00

z 33 1 JD 3020 31/08/2016 Ledger  Ledger Year End 14,009.00 0.00  14,009.00

5 364 1 ID 3050 31/08/2016 Ledger  Ledger Year End 34,866.33 0.00 34,866.33

& 35 1 JD 3100 31/08/2016 Ledger  Ledger Year End 10,451.67 0.00  10,451.67

g 36 1 JD 3130 31/08/2016 Ledger  Ledger Year End 8,395.67 0.00 839567

= 37 1 ID 3240 31/08/2016 Ledger  Ledger Year End 550.86 0.00 590.86

li 368 1 JD 3250 31/08/2016 Ledger  Ledger Year End 207.00 0.00 207.00

E 369 1 ID 3275 31/08/2016 Ledger  Ledger Year End 2,310.00 0.00  2,310.00

= 370 1 JD 3290 31/08/2016 Ledger  Ledger Year End 1,998.00 0.00  1,998.00

= 371 1 JD 3330 31/08/2016 Ledger  Ledger Year End 2,300.00 0.00  2,300.00

2 372 1 I 333 31/08/2016 Ledger  Ledger Year End 486.00 0.00 486.00

= 373 1 JD 3370 31/08/2016 Ledger  Ledger Year End 25.00 0.00 25.00

it 374 1 ID 3390 31/08/2016 Ledger  Ledger Year End 10,050.00 0.00  10,050.00

2 375 1 JD 3420 31/08/2016 Ledger  Ledger Year End 6,863.50 0.00  6,863.50

= 376 1 ID 3450 31/08/2016 Ledger  Ledger Year End 94.00 0.00 94,00

= 377 1 ID 3490 31/08/2016 Ledger  Ledger Year End 1,811.50 0.00  1,811.50 -

z 378 1 ID 3495 31/08/2016 Ledger  Ledger Year End 410.00 0.00 410.00 =

< 379 1 ID 3500 31/08/2016 Ledger  Ledger Year End 32.00 0.00 32.00 a

i 380 1 JD 3510 31/08/2016 Ledger  Ledger Year End 773.00 0.00 773.00 g

Z 381 1 JC 4150 31/08/2016 Ledger  Ledger Year End 819.60 0.00 819,60 =

=)
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8.5 Understanding The Year End Routine

Income and Expenditure account balances are cleared and the year to date figures on
these codes are transferred to the retained earnings nominal code using journals.

Balance Sheet balances are brought forward to the new financial year and included in the
year to date values on the balance sheet report.

The audit trail is updated with the ledger year end journals that are posted to clear the
income and expenditure accounts.

The Nominal Records are updated with the actual monthly balances for the current
financial year transferred to the Prior Year column. Any future transactions in the previous
year become current year actuals

Supplier Records are updated — the values in the YTD fields on all suppliers are transferred
to the prior year field. Any future dated transactions are transferred into the relevant monthly
field in each supplier

Customer Records are updated — the values in the YTD fields on all customers are
transferred to the prior year field. Any future dated transactions are transferred into the
relevant monthly field in each customer.

The Financial Year start date is moved to the next financial year end.
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8.6 Posting Transactions after the Year End

»  Of course, there may be the occasional transaction that you need to enter after you run
your year end that relates to the previous year.

+ If this happens, you can still post late entries back into the previous year. If you know the
approximate value of these late entries before you run the year end, you can also post
transactions known as accruals to reflect their value in your year end figures.
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8.7 Financial Year End Reports

As part of the year end procedures the following reports should be printed and filed.
* Trial Balance
* Nominal Activity
* Audit trail
* Income and Expenditure
+ Balance Sheet
+ Bank reconciliation report
* Unreconciled receipts and payments
* Aged Suppliers list-detailed

+ Aged Customer list- detailed
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